Acronis Backup Advanced 11.7
Update 1

APPLIES TO THE FOLLOWING PRODUCTS

Advanced for Windows Server
Advanced for Linux Server
Advanced for PC
Advanced for VMware / Hyper-V / RHEV / Citrix XenServer / Oracle VM
Advanced for Exchange
Advanced for SQL
Advanced for SharePoint
Advanced for Active Directory
For Windows Server Essentials

INSTALLATION GUIDE
Table of contents

1 Before installation .................................................................................................................4
  1.1 About using the product in the trial mode .................................................................4
  1.2 Licenses for Acronis Backup and Acronis Backup Advanced .................................4
  1.3 Acronis Backup components .......................................................................................6
    1.3.1 Agent for Windows ........................................................................................................6
    1.3.2 Agent for Linux .............................................................................................................7
    1.3.3 Agent for VMware .......................................................................................................7
    1.3.4 Agent for Hyper-V ......................................................................................................8
    1.3.5 Agent for Exchange .....................................................................................................8
    1.3.6 Agent for SQL ..............................................................................................................8
    1.3.7 Agent for Active Directory ..........................................................................................8
    1.3.8 Components for centralized management .................................................................9
    1.3.9 Management Console .................................................................................................10
    1.3.10 Bootable Media Builder .............................................................................................10
  1.4 Licensing of Acronis Backup Advanced ......................................................................11
    1.4.1 How many licenses do I need? ..................................................................................11
    1.4.2 Licensing for virtual machines ..................................................................................12
  1.5 Supported operating systems .......................................................................................12
  1.6 System requirements ....................................................................................................16

2 Installing Acronis Backup Advanced.................................................................................18
  2.1 Installation in Windows .................................................................................................18
    2.1.1 Ways of installation in Windows ..............................................................................18
    2.1.2 Local installation .......................................................................................................20
    2.1.3 Installing the agent through Group Policy ..............................................................29
    2.1.4 Configuration script parameters .............................................................................32
    2.1.5 Installation from the management server Web page ...............................................34
    2.1.6 Installing Acronis License Server .............................................................................39
  2.2 Installation in Linux ......................................................................................................39
    2.2.1 Preparation ................................................................................................................39
    2.2.2 Interactive installation of Acronis Backup Advanced ..............................................42
    2.2.3 Installation in the unattended mode ........................................................................42
    2.2.4 Command-line parameters ......................................................................................43
  2.3 Remote installation ......................................................................................................45
    2.3.1 Prerequisites .............................................................................................................46
    2.3.2 Preparation ................................................................................................................46
    2.3.3 Installation procedure ...............................................................................................47
  2.4 Installation of Agent for VMware .................................................................................51
    2.4.1 Importing Agent for VMware (Virtual Appliance) ....................................................53
    2.4.2 Updating Agent for VMware (Virtual Appliance) ....................................................55
  2.5 Installation of Agent for Hyper-V ................................................................................56
  2.6 Installation for other virtualization platforms .............................................................57
  2.7 Installation of Agent for Exchange ..............................................................................58
  2.8 Installation of Agent for SQL .......................................................................................59
  2.9 Installation of Agent for Active Directory ....................................................................60
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Upgrading from Acronis Backup to Acronis Backup Advanced</td>
<td>61</td>
</tr>
<tr>
<td>4</td>
<td>Checking for software updates</td>
<td>62</td>
</tr>
<tr>
<td>5</td>
<td>Uninstallation</td>
<td>63</td>
</tr>
<tr>
<td>5.1</td>
<td>Uninstalling Acronis Backup Advanced</td>
<td>63</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Uninstallation in Windows</td>
<td>63</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Uninstallation in Linux</td>
<td>65</td>
</tr>
<tr>
<td>5.2</td>
<td>Deleting Agent for VMware (Virtual Appliance)</td>
<td>65</td>
</tr>
<tr>
<td>5.3</td>
<td>Deleting Acronis Secure Zone</td>
<td>66</td>
</tr>
</tbody>
</table>
1 Before installation

This section answers questions that might arise before the product installation.

1.1 About using the product in the trial mode

Before buying an Acronis Backup license, you may want to try the software. This can be done without a license key.

To install the product in the trial mode, run the setup program locally or use the remote installation (p. 45) functionality. Unattended installation and other ways of installation (p. 18) are not supported.

Limitations of the trial mode

When installed in the trial mode, Acronis Backup has the following limitation:

- The Universal Restore functionality is disabled.

Additional limitations for bootable media:

- The disk management functionality is not available. You can try the user interface, but there is no option to commit the changes.
- The recovery functionality is available, but the backup functionality is not. To try the backup functionality, install the software in the operating system.

Upgrading to the full mode

After the trial period expires, the product GUI displays a notification requesting you to specify or obtain a license key.

To specify a license key, click Help > Change License. Specifying the key by running the setup program is not possible.

If you have activated a trial or purchased a subscription for the cloud backup service, cloud backup will be available until the subscription period expires, regardless of whether you specify a license key.

1.2 Licenses for Acronis Backup and Acronis Backup Advanced

Licensing of the Acronis Backup product family and the Acronis Backup Advanced suite is based on the number of machines backed up by the products. A license is required for every physical machine that you want to back up.

The following table lists the products and their main features.

<table>
<thead>
<tr>
<th>Product</th>
<th>Disk and file backup</th>
<th>Centralized management</th>
<th>Deduplication</th>
<th>Backup to tape</th>
<th>Application backup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acronis Backup for Windows Server</td>
<td>+</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Acronis Backup for Linux Server</td>
<td>+</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Acronis Backup for PC</td>
<td>+</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
The products without centralized management are designed for backing up the data of a single machine. All components of each product are installed on the same machine. You will be asked for the license key during the installation.

The Acronis Backup Advanced suite is designed for backing up multiple machines. In addition to components that need to be installed on a backed-up machine, these products include a management server that enables centralized management and storage nodes for storing backed up data. Usage of these additional components is not licensed. For example, you can install as many storage nodes as you wish — up to 50.

During installation of a licensed component (agent), you can either specify a license server or enter a license key manually. Use a license for a specific product or Acronis Backup Advanced Universal License. This license enables installation of all Acronis Backup Advanced products on a physical machine and on any number of virtual machines running on this physical machine.

Acronis Backup for Windows Server Essentials is a natural choice for a network with a single server and multiple workstations. By using this product on the server and using Acronis Backup Advanced for PC on the workstations, you can centrally manage all of the machines. Most descriptions of the Acronis Backup Advanced functionality in the documentation also apply to Acronis Backup for Windows Server Essentials.

Components of other Acronis Backup products do not interact with the components of Acronis Backup Advanced.
1.3 Acronis Backup components

Acronis Backup includes the following main types of components.

Components for a managed machine (agents)

These are applications that perform data backup, recovery and other operations on the machines managed with Acronis Backup. Agents require a license to perform operations on each managed machine.

Components for centralized management

These components, included in Acronis Backup Advanced, provide centralized management capability. Usage of these components is not licensed.

Console

The console provides Graphical User Interface to other Acronis Backup components. Usage of the console is not licensed.

Bootable media builder

With bootable media builder, you can create bootable media in order to use the agents and other rescue utilities in a rescue environment.

Bootable Media Builder does not require a license if installed together with an agent. To use a media builder on a machine without an agent, you need to enter the license key or have at least one license on the license server. The license may be either available or assigned.

1.3.1 Agent for Windows

This agent enables disk-level and file-level data protection under Windows.

Disk backup

Disk-level data protection is based on backing up either a disk or a volume file system as a whole, along with all the information necessary for the operating system to boot; or all the disk sectors using the sector-by-sector approach (raw mode). A backup that contains a copy of a disk or a volume in a packaged form is called a disk (volume) backup or a disk (volume) image. It is possible to recover disks or volumes as a whole from such backup, as well as individual folders or files.

File backup

File-level data protection is based on backing up files and folders residing on the machine where the agent is installed or on a network share. Files can be recovered to their original location or to another place. It is possible to recover all files and folders that were backed up or select which of them to recover.

Other operations

Conversion to a virtual machine

Agent for Windows performs the conversion by recovering a disk backup to a new virtual machine of any of the following types: VMware Workstation, Microsoft Virtual PC, Citrix XenServer Open Virtual Appliance (OVA) or Red Hat Kernel-based Virtual Machine (KVM). Files of the fully configured and operational machine will be placed in the folder you select. You can start the machine using the respective virtualization software or prepare the machine files for further usage.
**Recovery to dissimilar hardware**

You can use the restore to dissimilar hardware functionality on the machine where the agent is installed and create bootable media with this functionality. Acronis Universal Restore handles differences in devices that are critical for the operating system start-up, such as storage controllers, motherboard or chipset.

**Disk management**

Agent for Windows includes Acronis Disk Director Lite - a handy disk management utility. Disk management operations, such as cloning disks; converting disks; creating, formatting and deleting volumes; changing a disk partitioning style between MBR and GPT or changing a disk label, can be performed either in the operating system or using bootable media.

### 1.3.2 Agent for Linux

This agent enables disk-level and file-level data protection under Linux.

**Disk backup**

Disk-level data protection is based on backing up either a disk or a volume file system as a whole, along with all information necessary for the operating system to boot; or all the disk sectors using the sector-by-sector approach (raw mode.) A backup that contains a copy of a disk or a volume in a packaged form is called a disk (volume) backup or a disk (volume) image. It is possible to recover disks or volumes as a whole from such backup, as well as individual folders or files.

**File backup**

File-level data protection is based on backing up files and directories residing on the machine where the agent is installed or on a network share accessed using the smb or nfs protocol. Files can be recovered to their original location or to another place. It is possible to recover all files and directories that were backed up or select which of them to recover.

**Conversion to a virtual machine**

Agent for Linux performs the conversion by recovering a disk backup to a new virtual machine of any of the following types: VMware Workstation, Microsoft Virtual PC, Citrix XenServer Open Virtual Appliance (OVA) or Red Hat Kernel-based Virtual Machine (KVM). Files of the fully configured and operational machine will be placed in the directory you select. You can start the machine using the respective virtualization software or prepare the machine files for further usage.

**Recovery to dissimilar hardware**

You can use the restore to dissimilar hardware functionality on the machine where the agent is installed and create bootable media with this functionality. Acronis Universal Restore handles differences in devices that are critical for the operating system start-up, such as storage controllers, motherboard or chipset.

### 1.3.3 Agent for VMware

Acronis Backup Agent for VMware enables backup and recovery of ESXi virtual machines without installing agents into the guest systems. This backup method is known as agent-less backup or backup at a hypervisor level.

The agent is delivered in two versions:
- Agent for VMware (Virtual Appliance) can be imported or deployed to a VMware ESX(i) host.
- For off-loaded backup, Agent for VMware (Windows) can be installed on a machine running Windows.

1.3.4 Agent for Hyper-V

Acronis Backup Agent for Hyper-V protects virtual machines residing on a Hyper-V virtualization server. The agent allows for backing up virtual machines from the host without having to install agents on each virtual machine.

1.3.5 Agent for Exchange

Acronis Backup Agent for Exchange enables you to back up and recover Microsoft Exchange databases or individual mailboxes.

The agent uses Microsoft VSS to ensure the consistency of the backed-up databases. Recovery of the smaller data items (e-mails, calendar events or notes) is available from both database and mailbox backups.

The agent is included in the setup program of Acronis Backup Advanced.

The agent is installed with Agent for Windows (p. 6) or on a machine where Agent for Windows is already installed.

1.3.6 Agent for SQL

Acronis Backup Agent for SQL enables you to create single-pass disk and application backups and to recover Microsoft SQL databases from them. The databases can be recovered directly to a running SQL Server instance or extracted to a folder on a file system.

The agent uses Microsoft VSS to ensure the consistency of the backed-up databases. After a successful backup, the agent can truncate the SQL Server transaction log.

The agent is included in the setup program of Acronis Backup Advanced.

The agent is installed with Agent for Windows (p. 6) or on a machine where Agent for Windows is already installed.

1.3.7 Agent for Active Directory

Acronis Backup Agent for Active Directory enables you to create single-pass disk and application backups and to extract Microsoft Active Directory data from them to a folder on a file system.

The agent uses Microsoft VSS to ensure the consistency of the backed-up data.

The agent is included in the setup program of Acronis Backup Advanced.

The agent is installed with Agent for Windows (p. 6) or on a machine where Agent for Windows is already installed.
1.3.8 Components for centralized management

This section lists the components that are included in Acronis Backup Advanced and provide the centralized management capability. Besides these components, Acronis Backup Agents have to be installed on all machines that need data protection.

1.3.8.1 Management Server

Acronis Backup Management Server is the central server that drives data protection within the enterprise network. The management server provides the administrator with:

- a single entry point to the Acronis Backup infrastructure
- an easy way to protect data on numerous machines using centralized backup plans and grouping
- integration with VMware vCenter to discover virtual machines for protection
- enterprise-wide monitoring and reporting functionality
- built-in license management
- the ability to create centralized vaults for storing enterprise backup archives
- the ability to manage storage nodes
- the centralized catalog of all data stored on the storage nodes.

If there are multiple management servers on the network, they operate independently, manage different machines and use different centralized vaults for storing archives.

1.3.8.2 Storage Node

Acronis Backup Storage Node is a server designed to optimize the usage of various resources (such as the corporate storage capacity, the network bandwidth, or the managed machines' CPU load) which are required to protect the enterprise data. This goal is achieved by organizing and managing the locations that serve as dedicated storages of the enterprise backup archives (managed vaults).

The most important function of a storage node is deduplication of backups stored in its vaults. This means that identical data will be backed up to this vault only once. This minimizes the network usage during backup and storage space taken by the archives.

The storage nodes enable creating highly scalable and flexible, in terms of the hardware support, storage infrastructure. Up to 50 storage nodes can be set up, each being able to manage up to 20 vaults.

The administrator controls the storage nodes centrally from the Acronis Backup Management Server (p. 9). Direct console connection to a storage node is not possible.

1.3.8.3 Components for Remote Installation

These are Acronis component installation packages used by the management console (p. 10) for installation on remote machines.

Components for Remote Installation need to be installed on the machine with the console or with the management server (p. 9). During installation, the setup program saves the components in the default location and saves this location path in the registry. As a result, the components are readily available in the Remote Installation Wizard (p. 45) as "registered components".
1.3.8.4  PXE Server

Acronis PXE Server allows for booting machines into Acronis bootable components through the network.

The network booting:

- Eliminates the need to have a technician onsite to install the bootable media into the system that has to be booted
- During group operations, reduces the time required for booting multiple machines as compared to using physical bootable media.

1.3.8.5  License Server

The server enables you to manage licenses of Acronis products and install the components that require licenses.

You can install a license server as a separate component (p. 39) or use the one integrated into the management server. The functionality of the license server is similar for both types of installation.

1.3.8.6  Acronis Wake-on-LAN Proxy

Acronis Wake-on-LAN Proxy enables Acronis Backup Management Server to wake up for backup machines located in another subnet. Acronis Wake-on-LAN Proxy installs on any server in the subnet where the machines to be backed up are located.

1.3.9  Management Console

Acronis Backup Management Console is an administrative tool for access to Acronis Backup agents and, in Acronis Backup Advanced, to Acronis Backup Management Server.

The console has two distributions: for installation on Windows and installation on Linux. While both distributions enable connection to any Acronis Backup agent and Acronis Backup Management Server, we recommend that you use the console for Windows if you have a choice between the two. The console that installs on Linux has limited functionality:

- Remote installation of Acronis Backup components is not available.
- The Active Directory-related features, such as browsing the AD, are not available.

1.3.10  Bootable Media Builder

Acronis Bootable Media Builder is a dedicated tool for creating bootable media. There are two media builder distributions: for installation in Windows and installation in Linux.

The media builder that installs on Windows can create bootable media based on either Windows Preinstallation Environment, or Linux kernel. The media builder that installs on Linux creates bootable media based on Linux kernel.
1.4 Licensing of Acronis Backup Advanced

Acronis License Server

Licenses of Acronis Backup Advanced are managed by Acronis License Server. You can install a license server as a separate component (p. 39) or use the one integrated into the management server. The functionality of the license server is similar for both types of installation.

Acronis License Server can import multiple license keys from .txt or .eml files, saving you from the time-consuming procedure of typing in numbers.

Specifying licenses during installation

During installation of a licensed component (agent), you can either specify the license server or enter a license key manually. When you register the machine on the management server, the manually entered key will be imported to the server and will be seen in the list of licenses.

Installation of an agent is possible without specifying a license or a license server in the following cases:

- When installing the software in the trial mode (p. 4).
- When installing the software for cloud backup only. Such backup does not require a license, but requires a subscription for the Acronis Cloud Backup service.
- When installing Agent for VMware (p. 7) (both versions). The licenses will be consumed later, when a backup of the specified virtual machines starts. One license will be required for each host where a virtual machine is selected for backup.

Checking licenses

An Acronis agent connects to Acronis License Server every time the agent service starts and then every 1–5 days, as specified by the agent configuration parameters. If the agent is unable to connect to the license server, it initiates an alert. The agent keeps working without the license server for 1–60 days (as specified by the configuration parameters). After that, the agent stops doing backups (except for cloud backups) until a successful license check is completed.

If the agent connects to the license server but does not find the acquired license, it tries to acquire another license. If no license is available, the agent stops doing backups (except for cloud backups) until a license is successfully acquired.

By default, the agent tries to connect to the license server every day and keeps working without a license server for 30 days.

1.4.1 How many licenses do I need?

Assume that your company network includes a server and five workstations running Windows. All the machines are backed up by the administrator who prefers setting up and monitoring backups from a single place. Therefore, you consider licenses for Acronis Backup Advanced. The cost of a license for a workstation is less than for a server.

To protect all the machines, you need:

- Five Acronis Backup Advanced for PC licenses
- One Acronis Backup Advanced for Windows Server license.
1.4.2 Licensing for virtual machines

The licenses for virtual environments enable backing up a physical host and an unlimited number of hosted virtual machines.

You can install the product into the guest systems, back them up from the host, or combine both methods. Any Acronis Backup agent, including Agent for Exchange, Agent for SQL, and Agent for Active Directory, can be installed without additional licenses.

For a VMware vSphere or Microsoft Hyper-V cluster, you need as many licenses as there are nodes in the cluster.

The following table enables you to define which license is required for your virtualization platform.

<table>
<thead>
<tr>
<th>License name</th>
<th>Virtualization platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acronis Backup Advanced for VMware</td>
<td>Any supported platform developed by VMware (ESX, ESXi, VMware Workstation, VMware ACE)*</td>
</tr>
<tr>
<td>Acronis Backup Advanced for Hyper-V</td>
<td>Any supported platform developed by Microsoft (Hyper-V, Windows Virtual PC)*</td>
</tr>
<tr>
<td>Acronis Backup Advanced for RHEV</td>
<td>Red Hat Enterprise Virtualization</td>
</tr>
<tr>
<td></td>
<td>Kernel-based Virtual Machines (KVM)</td>
</tr>
<tr>
<td>Acronis Backup Advanced for Citrix XenServer</td>
<td>Citrix XenServer</td>
</tr>
<tr>
<td>Acronis Backup Advanced for Oracle VM</td>
<td>Oracle VM Server</td>
</tr>
<tr>
<td></td>
<td>Oracle VM VirtualBox</td>
</tr>
<tr>
<td>Acronis Backup Advanced Universal License</td>
<td>All of the above</td>
</tr>
<tr>
<td></td>
<td>Parallels Workstation</td>
</tr>
<tr>
<td></td>
<td>Parallels Server Bare Metal</td>
</tr>
</tbody>
</table>

*For a complete list of supported virtualization platforms, refer to "Supported virtualization platforms" in the "Backing up virtual machines" document.

1.5 Supported operating systems

Components for a managed machine

Important: Refer to "Support for Windows 8 and Windows Server 2012" in the product Help or the User Guide for details and limitations of this support.

**Acronis Backup Agent for Windows**

- Acronis Backup Advanced for Windows Server
- Acronis Backup Advanced for Hyper-V
- Acronis Backup Advanced for VMware
- Acronis Backup Advanced for Citrix XenServer
- Acronis Backup Advanced for RHEV
- Acronis Backup Advanced for Oracle VM
- Acronis Backup Advanced Universal License
  - Windows XP Professional SP2+ (x86, x64)
  - Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64)
Windows Small Business Server 2003/2003 R2
Windows Vista – all editions (x86, x64), except for Vista Home Basic and Vista Home Premium
Windows Server 2008 – Standard, Enterprise, Datacenter, and Web editions (x86, x64)
Windows Small Business Server 2008
Windows 7 – all editions (x86, x64), except for the Starter and Home editions
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, Foundation, and Web editions
Windows Small Business Server 2011 – all editions
Windows 8/8.1 – all editions (x86, x64), except for the Windows RT editions
Windows Server 2012/2012 R2 – all editions
Windows 10 – Home, Pro, Education, Enterprise, and IoT Enterprise editions
Windows Server 2016 – all installation options, except for Nano Server

**Acronis Backup for Windows Server Essentials**
Windows Small Business Server 2003/2003 R2
Windows Small Business Server 2008
Windows Small Business Server 2011 – all editions
Windows Server 2012/2012 R2 – Essentials and Foundation editions

**Acronis Backup Advanced for PC**
Windows XP Professional SP2+ (x86, x64)
Windows Vista – all editions (x86, x64), except for Vista Home Basic and Vista Home Premium
Windows 7 – all editions (x86, x64), except for the Starter and Home editions
Windows 8/8.1 – all editions (x86, x64), except for the Windows RT editions
Windows 10 – Home, Pro, Education, Enterprise, and IoT Enterprise editions

**Acronis Backup Agent for Exchange**
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64)
Windows Small Business Server 2003/2003 R2
Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64)
Windows Small Business Server 2008
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions
Windows Small Business Server 2011 – all editions
Windows Server 2012/2012 R2 – Standard and Datacenter editions
Windows Server 2016 – all installation options, except for Nano Server

**Acronis Backup Agent for SQL**
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64)
Windows Small Business Server 2003/2003 R2
Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64)
Windows Small Business Server 2008
Windows 7 – all editions (x86, x64), except for the Starter and Home editions
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions
Windows Small Business Server 2011 – all editions
Windows 8/8.1 – all editions (x86, x64), except for the Windows RT editions
Windows Server 2012/2012 R2 – all editions
Windows 10 – Home, Pro, Education, and Enterprise editions
Windows Server 2016 – all installation options, except for Nano Server

**Acronis Backup Agent for Active Directory**
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64)
Windows Small Business Server 2003/2003 R2
Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64)
Windows Small Business Server 2008
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions
Windows Small Business Server 2011 – all editions
Windows Server 2012/2012 R2 – all editions
Windows Server 2016 – all installation options, except for Nano Server

**Acronis Backup Agent for Linux**
[Acronis Backup Advanced for Linux Server](#)
[Acronis Backup Advanced for Hyper-V](#)
[Acronis Backup Advanced for VMware](#)
[Acronis Backup Advanced for Citrix XenServer](#)
[Acronis Backup Advanced for RHEV](#)
[Acronis Backup Advanced for Oracle VM](#)
[Acronis Backup Advanced Universal License](#)

Linux with kernel from 2.4.20 to 4.14 and glibc 2.3.2 or later
Various x86 and x86_64 Linux distributions, including:
  - Red Hat Enterprise Linux 4.x, 5.x, 6.x, 7.0, 7.1, 7.2, 7.3, 7.4
  - Fedora 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27
  - SUSE Linux Enterprise Server 10 and 11
  - SUSE Linux Enterprise Server 12 – supported on file systems, except for Btrfs
  - Debian 4, 5, 6, 7.0, 7.2, 7.4, 7.5, 7.6, 7.7, 8.0, 8.1, 8.2, 8.3, 8.4, 8.5, 8.6
  - CentOS 5.x, 6.x, 7, 7.1, 7.2, 7.3, 7.4
  - Oracle Linux 5.x, 6.x, 7.0, 7.1, 7.2, 7.3, 7.4 – both Unbreakable Enterprise Kernel and Red Hat Compatible Kernel
  - CloudLinux 6.x
  - ClearOS 5.x, 6.x, 7, 7.1

Before installing the product on a system that does not use RPM Package Manager, such as an Ubuntu system, you need to install this manager manually; for example, by running the following command (as the root user): `apt-get install rpm`
Acronis Backup Agent for Hyper-V

- Windows Server 2008 (x64 only) with Hyper-V
- Windows Server 2008 R2 with Hyper-V
- Microsoft Hyper-V Server 2008/2008 R2
- Windows Server 2012/2012 R2 with Hyper-V
- Microsoft Hyper-V Server 2012/2012 R2
- Windows 8, 8.1 (x64 only) with Hyper-V
- Windows 10 – Pro, Education, and Enterprise editions with Hyper-V
- Windows Server 2016 with Hyper-V – all installation options, except for Nano Server
- Microsoft Hyper-V Server 2016

Acronis Backup Agent for VMware (Virtual Appliance)

This agent is delivered as a virtual appliance for running on an ESX(i) host.

- VMware ESX(i) 4.0, 4.1, 5.0, 5.1, 5.5, 6.0, 6.5

Acronis Backup Agent for VMware (Windows)

This agent is delivered as a Windows application for running in any operating system listed above for Acronis Backup Agent for Windows (under Acronis Backup Advanced for VMware).

Components for centralized management

Acronis Backup Management Server, Acronis License Server, Acronis Backup Storage Node

- Windows XP Professional SP3 (x86, x64)
- Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64)
- Windows Vista – all editions (x86, x64), except for Vista Home Basic and Vista Home Premium
- Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64)
- Windows Small Business Server 2008
- Windows 7 – all editions (x86, x64), except for the Starter and Home editions
- Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions
- Windows Small Business Server 2011 – all editions
- Windows 8/8.1 – all editions (x86, x64), except for the Windows RT editions
- Windows Server 2012/2012 R2 – all editions
- Windows 10 – Home, Pro, Education, Enterprise, and IoT Enterprise editions
- Windows Server 2016 – all installation options, except for Nano Server

Acronis Backup Management Console

- Windows XP Professional SP2+ (x86, x64)
- Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64)
- Windows Vista – all editions (x86, x64)
- Windows Server 2008 – Standard, Enterprise, Datacenter, and Web editions (x86, x64)
- Windows Small Business Server 2008
### System requirements

#### The components installed in operating systems

To calculate the total required disk space, add up the values specified in the third and fourth columns of the table for the components you are planning to install.

<table>
<thead>
<tr>
<th>Component</th>
<th>Memory (above the OS and running applications)</th>
<th>Disk space required during installation or update</th>
<th>Disk space occupied by the component(s)</th>
<th>Additional</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The components installed in Windows</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete installation</td>
<td>350 MB</td>
<td>5.8 GB</td>
<td>4.4 GB  including SQL Express Server</td>
<td></td>
</tr>
<tr>
<td>Agent Core</td>
<td>140 MB</td>
<td>420 MB</td>
<td>270 MB</td>
<td></td>
</tr>
<tr>
<td>Agent for Windows</td>
<td>375 MB</td>
<td>1 GB</td>
<td>660 MB</td>
<td></td>
</tr>
<tr>
<td>Agent for VMware (Windows)</td>
<td>90 MB</td>
<td>140 MB</td>
<td>100 MB</td>
<td></td>
</tr>
<tr>
<td>Agent for Hyper-V</td>
<td>80 MB</td>
<td>60 MB</td>
<td>30 MB</td>
<td></td>
</tr>
<tr>
<td>Agent for Exchange</td>
<td>100 MB</td>
<td>170 MB</td>
<td>90 MB</td>
<td></td>
</tr>
<tr>
<td>Bootable Media Builder</td>
<td>370 MB</td>
<td>1.3 GB</td>
<td>880 MB</td>
<td>CD-RW or DVD-RW drive</td>
</tr>
<tr>
<td>Management Console</td>
<td>180 MB</td>
<td>490 MB</td>
<td>330 MB</td>
<td>Screen resolution 800*600 pixels or higher</td>
</tr>
<tr>
<td>Management Server (up to 200 managed machines)</td>
<td>350 MB</td>
<td>940 MB</td>
<td>640 MB</td>
<td></td>
</tr>
<tr>
<td>Management Server (more than 200 managed machines)</td>
<td>Refer to the following Acronis Knowledge Base article: <a href="http://kb.acronis.com/content/40678">http://kb.acronis.com/content/40678</a>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wake-on-LAN Proxy</td>
<td>70 MB</td>
<td>40 MB</td>
<td>15 MB</td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Memory (above the OS and running applications)</td>
<td>Disk space required during installation or update</td>
<td>Disk space occupied by the component(s)</td>
<td>Additional</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Storage Node (general requirements)</td>
<td>180 MB</td>
<td>470 MB</td>
<td>290 MB</td>
<td>When using a tape library, space required for tapes database: approx. 1 MB per 10 archives</td>
</tr>
<tr>
<td>Storage Node (requirements for using Deduplication)</td>
<td></td>
<td></td>
<td></td>
<td>Minimum 8 GB of RAM.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>64-bit platform.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For more information, see “Deduplication best practices” in the product Help or the User Guide.</td>
</tr>
<tr>
<td>License Server</td>
<td>65 MB</td>
<td>60 MB</td>
<td>40 MB</td>
<td></td>
</tr>
<tr>
<td>PXE Server</td>
<td>80 MB</td>
<td>95 MB</td>
<td>60 MB</td>
<td></td>
</tr>
<tr>
<td>Tray Monitor</td>
<td>65 MB</td>
<td>25 MB</td>
<td>10 MB</td>
<td></td>
</tr>
<tr>
<td>The components installed in Linux</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent for Linux</td>
<td>120 MB</td>
<td>200 MB</td>
<td>210 MB</td>
<td></td>
</tr>
<tr>
<td>Bootable Media Builder</td>
<td>130 MB</td>
<td>300 MB</td>
<td>330 MB</td>
<td></td>
</tr>
<tr>
<td>Management Console</td>
<td>120 MB</td>
<td>100 MB</td>
<td>200 MB</td>
<td></td>
</tr>
<tr>
<td>The components installed on VMware ESX(i) server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent for VMware (Virtual Appliance)</td>
<td>Minimum 1 GB</td>
<td>6 GB</td>
<td>6 GB</td>
<td>CPU number: 2 (the default Virtual Appliance setting)</td>
</tr>
<tr>
<td></td>
<td>The OVF template setting is 2 GB.*</td>
<td></td>
<td></td>
<td>4-8 (recommended if backing up 5–10 VMs simultaneously)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CPU reservation: minimum 300 MHz recommended</td>
</tr>
</tbody>
</table>

*When the agent is deployed from the management server, its memory size is set automatically as follows:

- 1 GB if the host RAM is less than or equal to 16 GB.
- 2 GB if the host RAM is between 16 GB and 64 GB.
- 4 GB if the host RAM is more than 64 GB.

Network interface card or virtual network adapter is a common requirement for all the components.

**Bootable media**

<table>
<thead>
<tr>
<th>Media type</th>
<th>Memory</th>
<th>ISO image size</th>
<th>Additional</th>
</tr>
</thead>
</table>

*When the agent is deployed from the management server, its memory size is set automatically as follows:
2 Installing Acronis Backup Advanced

This section helps answer questions that might arise during the product installation.

2.1 Installation in Windows

This section describes installation of Acronis Backup components on a machine running Windows.

2.1.1 Ways of installation in Windows

Components of Acronis Backup Advanced can be installed in different ways. Based on the size and structure of your environment, choose any of the ways of installation described in this section.

You can combine two or more ways of installation. For example, you can perform interactive installation of the management console and the management server, and then remotely install the agents to multiple machines.

By using interactive or Web-based installation, you can install any component. Other ways of installation are intended primarily for installing the agents.

Interactive installation (p. 20)

In this way of installation, you run a self-contained setup program and follow the on-screen instructions.

**Advantages:** The setup program includes all components for Windows.

**Disadvantages:** Large size of the setup program.

**Usage examples:**
- Installing the management console, management server and storage nodes.
- Installing agents on a small number of machines.

Web-based installation (p. 26)

In this way of installation, you run a lightweight setup program and follow the on-screen instructions. The setup program downloads from the Acronis website only the components that you selected to install.

**Advantages:** Small size of the setup program.

**Disadvantages:** Large amounts of the same data may be transferred over the Internet (for example, when installing the agent on many machines). To overcome this disadvantage, save the downloaded installation packages (p. 26) to a network folder.

**Usage examples:** Installing agents in a small network with slow Internet access (you do not need to download the large setup program from the Acronis website).
Remote installation (p. 45)

Prerequisite: the management console must be already installed.

In this way of installation, you install the software remotely on a number of machines. You can do this from the management console’s welcome screen or when adding machines to the management server.

Advantages: Installation can be performed centrally by an administrator and is transparent to end users.

Disadvantages: Several preparatory steps (p. 46) must be performed on the target machines before installation.

Usage examples:
- Installing agents on a large number of machines in a local network.
- Adding a machine without an agent to the management server.

Unattended installation (p. 27)

In this way of installation, you run installation packages (.msi files) with command-line parameters.

Advantages: Installation can be performed by a script.

Disadvantages: Installation is harder to configure (you may need to create a transform, or an .mst file).

Usage examples: Installing agents on a large number of machines running Windows.

Installation through Group Policy (p. 29)

In this way of installation, you deploy installation packages (.msi files) in an Active Directory domain by using Group Policy.

Advantages: Installation can be performed centrally by an administrator in an entire domain. It is performed under a system account and is transparent to end users.

Disadvantages: Installation is harder to configure (you may need to create a transform, or an .mst file). The machines must be in a domain.

Usage examples: Installing agents on a large number of machines in an Active Directory domain.

Installation from the management server Web page (p. 34)

Prerequisite: the management server must be already installed.

In this way of installation, you go to the Web page on the management server, and install the software without having to specify installation settings.

Advantages:
- Installation can be performed by an end user on any machine with a supported Web browser.
- The components are downloaded from the local network instead of over the Internet.
- The end user does not need to specify installation settings.
- The machine can be automatically registered on the management server.

Disadvantages: The end user still must have rights to install software on the machine (for example, be a local administrator on it).
Usage examples:

- Enabling laptop users (who may connect to the corporate network at irregular intervals) to install the program on their own.
- Accessing installation packages in a network that does not allow sharing folders.

2.1.2 Local installation

You have a choice between a setup program that contains all components, and a lightweight setup program that will download from the Acronis website only the components that you select to install.

Installation can be performed in the interactive or the unattended mode.

2.1.2.1 Preparation

**Network port.** Acronis Backup uses TCP port 9876 for local installation and for communication between components. The setup program automatically opens this port through Windows Firewall. If you use a different firewall, make sure that the port is open for both incoming and outgoing requests through that firewall.

**Encryption software.** If you are planning to use disk-level encryption software, such as PGP Whole Disk Encryption, make sure to install such software before installing Acronis Backup.

2.1.2.2 Interactive installation of Acronis Backup Advanced

You can install Acronis Backup Advanced on the local machine by using the typical or the custom installation. **Typical installation** is the easiest way to install the product. Most of the installation parameters will be set to their default values. During **custom installation**, you will be able to select the components to be installed and to specify additional parameters.

*Note: When canceling the installation process, only the last package is removed. Other components, if any, remain installed.*

**Typical installation**

1. Log on as an administrator and start the Acronis Backup Advanced setup program.
2. Click **Install Acronis Backup**.
3. Accept the terms of the license agreement.
4. Select one or more machine roles, depending on what you want this machine to do.
   - Based on your choice, the corresponding components (p. 22) of Acronis Backup will be selected for installation.
5. If you chose to back up this machine's data, and the machine has applications that Acronis Backup can back up, select the applications that you want to protect with the application-specific backup.
   - Based on your choice, additional components, such as Agent for Exchange or Agent for Hyper-V, will be selected for installation.
6. If prompted, specify one or more of the following parameters, depending on the component selection:
   - Installation mode (trial or full) (p. 22).
   - Whether to register the components on the management server (p. 25).
   - Credentials for Microsoft SQL Server instances installed on the machine (p. 59).
- Whether the machine will participate in the Acronis Customer Experience Program (CEP).

7. On the summary page, review the list of components that will be installed, and the installation settings for those components. Click **Install** to start the installation.

**Custom installation**

1. Log on as an administrator and start the Acronis Backup Advanced setup program.
2. Click **Install Acronis Backup**.
3. Accept the terms of the license agreement.
4. Select the **I want to manually select the Acronis components and customize the installation process** check box.
   You can also select one or more of the machine roles, depending on what you want this machine to do. Based on your choice, the corresponding components (p. 22) of Acronis Backup will be selected for installation.
5. [Optional] In the components tree, select additional components or clear selection of the components that you do not want to install.
   **Tips.** Agent for VMware (Windows), Wake-on-LAN Proxy, and some smaller features can be installed only by using the components tree.
   You may want to disable **Components for Remote Installation** from being saved every time you install the management console, because the installation files take about 900 MB of disk space.
6. If prompted, specify one or more of the following parameters, depending on the component selection:
   - Installation mode (trial or full) (p. 22).
   - The name or IP address of the license server that Agent for VMware (Windows) will use.
   - The folder where the product will be installed.
   - Whether to install the product for all users or only for the current user.
   - Credentials for the Acronis services (p. 23). By default, the setup program will create a dedicated user account for each service.
   - The names of Microsoft SQL servers to be used by Acronis Backup Management Server (p. 24).
   - Whether to register the components on the management server (p. 25).
   - The names of users who will be allowed to connect to the machine remotely (p. 26).
   - The name or IP address of the VMware vCenter Server or ESX(i) server whose virtual machines Agent for VMware (Windows) will back up. Specify the user name and password for logging on to that server. If you do not want to specify the server, click **I will specify the server later**.
   - Whether to enable the management server Web page. (If enabled, specify the port for the Web page). (p. 34)
   - Credentials for Microsoft SQL Server instances installed on the machine (p. 59).
   - Whether the machine will participate in the Acronis Customer Experience Program (CEP).

7. On the summary page, review the list of components that will be installed and the installation settings for those components. Click **Install** to start the installation.
Installation mode

When installing agents, choose the full installation mode if you have a license key or a cloud backup subscription. Choose the trial mode if you have neither.

Installing in the trial mode

- During typical installation: Select I want to start a free trial.
- During custom installation: In License for backup of ..., select Trial mode, and then click Next.

The product will be installed in the trial mode (p. 4).

Installing in the full mode

1. [During typical installation only] Select I purchased a license or a subscription, and then click Next.
2. If you have a license key, choose whether to take licenses from a license server or to store them locally on the machine. Otherwise, skip this step.
   - To take licenses from a license server, select the Use the following license server check box, and then specify the name or IP address of the license server. If the license server does not contain the required license keys, type the license keys or import them from a text file. We recommend specifying the management server as the license server, unless you already have a separate license server. If the management server is being installed, the local machine is selected by default.
   - To store the machine's licenses on the machine itself, ensure that the license server is not selected. Otherwise, clear the Use the following license server check box. Then, type the license keys or import them from a text file.
3. Skip this step if you do not have a cloud backup subscription, or if you have already registered your subscriptions, or if the machine is not connected to the Internet. Otherwise, do the following:
   a. Type the subscription registration codes or import them from a text file. Please do not try to import the subscription keys to Acronis License Server.
   b. Enter your Acronis account credentials. If you do not have an Acronis account, click Create account, and then complete the account creation form.
4. If you skipped steps 2 and 3, in License for backup of ..., select Cloud backup only - license not required.
5. If the license server (or the set of licenses that you entered) contains licenses for more than one product, select the product that you want to install. By default, the cheapest license applicable to the machine’s operating system is selected.
6. If a license is missing in any of the License for backup of ... sections, click Back, and then add the necessary licenses, as described in step 2.

Components installed during typical installation

When performing the typical installation on a machine, you select the roles you want the machine to perform. Based on your choice, the following components of Acronis Backup will be installed.

- Back up this machine's data.
  - Agent Core
  - Agents (depending on the data types that are present on the machine):
    - Agent for Windows
---

- Agent for Exchange
- Agent for SQL
- Agent for Active Directory
- Agent for Hyper-V
- Management Console
- Command-Line Tool
- **Centrally monitor and configure the backing up of physical and virtual machines.**
  - Management Server
  - Management Console
  - Components for Remote Installation*
  - Command-Line Tool
  - License Server
- **Store the backups of other machines on this machine.**
  - Storage Node
  - Command-Line Tool
- **Connect to remote machines.**
  - Management Console
  - Bootable Media Builder
  - Components for Remote Installation*
  - Command-Line Tool
* The components are installed only if the setup file is in a local folder.

---

**Specifying credentials for Acronis services**

The following Acronis Backup components run as services: Acronis Backup agents, Acronis Backup Management Server, and Acronis Backup Storage Node. When installing any of these components, you need to specify the account under which the component’s service will run.

---

*All Acronis Backup agents installed on a machine use the common Acronis Managed Machine Service, also referred to as the agent service.*

---

For each service, you can choose to create a new user account or specify an existing account of a local or domain user; for example: `\LocalUser` or `DomainName\DomainUser`

By default, the setup program will create a new dedicated account for each of the services.

**When to consider an existing account?**

New accounts fit most cases. Consider existing accounts in the following cases:

- **The machine is a domain controller in an Active Directory domain.**
  You must specify existing accounts (or the same account) for each service. For security reasons, the setup program does not automatically create new accounts on a domain controller.

- **You are installing an agent on a failover cluster node.**
  When installing an agent on a failover cluster node, such as a Hyper-V cluster node or a cluster node of Microsoft Exchange Server, specify an existing account of a domain user for the agent service. The account must have administrative privileges on each of the cluster nodes. With this account the agent will be able to access the clustered resources on any of the nodes.
Alternatively, you can choose to create a new account for the agent. Then, when creating centralized backup plans or recovery tasks, you will need to specify credentials for the domain account with the necessary privileges.

- You want the management server to use an existing Microsoft SQL server.
  Specify an existing account for the management server service if the management server and the SQL server are installed on different machines and you want to use Windows Authentication for the SQL server. For more details, see “Specifying Microsoft SQL servers” (p. 24).

### Privileges for accounts

Both existing and newly created accounts are given the following privileges:

- The accounts for the **agent service** and the **storage node service** are included in the **Backup Operators** group.
  
  *New* accounts for the **agent service** and the **storage node service** are also included in the **Administrators** group. If you specify an *existing* account for the **storage node service**, we recommend that this account be a member of the **Administrators** group. Otherwise, the service may lack access to some Windows resources. For security reasons, the setup program does not automatically include *existing* accounts in the **Administrators** group.

- The account for the **management server service** is included in the **Acronis Centralized Admins** group.

- All three accounts are assigned the **Log on as a service** user right.

- All three accounts are granted the **Full Control** permission on the folder %PROGRAMDATA%\Acronis (in Windows XP and Server 2003, %ALLUSERSPROFILE%\Application Data\Acronis) and on its subfolders.

- Each of the three accounts is granted the **Full Control** permission on certain registry keys in the following key: HKEY_LOCAL_MACHINE\SOFTWARE\Acronis.

- The account for the **agent service** is assigned the **Adjust memory quotas for a process**, **Replace a process level token** and **Modify firmware environment values** user rights.

### Tips for further usage

- The new accounts for the agent service, the management server service, and the storage node service have the names **Acronis Agent User**, **AMS User**, and **ASN User**, respectively.

- If the machine is part of an Active Directory domain, make sure that the domain’s security policies do not prevent the accounts described in this section (whether existing or newly created) from having the above listed user rights.

- After the installation, avoid specifying a different account for a component’s service. Otherwise, the component may stop working. If you must specify a different account, make sure that the new account is granted the above listed privileges.

### Specifying Microsoft SQL servers

When installing Acronis Backup Management Server, you need to specify the Microsoft SQL servers that the management server will use:

- **The operational SQL server** ensures synchronization of the Acronis Backup components. It stores a database with rapidly changing operational data. Therefore, we recommend that it reside on the same machine as the management server.

- **The reporting SQL server** stores the operation log and statistics. The databases stored on this server may become considerably large over time. The reporting SQL server can be the same as
the operational SQL server, or it can be a different server that is installed on the same or a
different machine.

By default, a new instance of Microsoft SQL Server 2008 Express will be installed on the machine and
used as both the operational and the reporting SQL server. The name of the instance is ACRONIS.
Click Change if you want to specify a different name or select an existing SQL server instance.

Selecting an existing SQL server instance

You can select any edition of Microsoft SQL Server 2005, Microsoft SQL Server 2008/2008 R2,
Microsoft SQL Server 2012, Microsoft SQL Server 2014, or Microsoft SQL Server 2016. The instance
you choose can also be used by other programs.

Before selecting an instance installed on another machine, make sure that SQL Server Browser
Service and the TCP/IP protocol are enabled on that machine. For instructions on how to start SQL
enable the TCP/IP protocol by using a similar procedure.

Instance name. Specify the instance name in the form MachineName\InstanceName. For example,
specify: dbserver\MyDatabases. If only one SQL server instance is installed on the machine, you can
specify just the machine name.

Authentication. Choose whether the management server will use Windows Authentication or SQL
Server Authentication to connect to the SQL server.

- If you choose Windows Authentication (recommended by Microsoft as more secure), the
management server will connect using the account of the management server service (p. 23).
  - If the SQL server and the management server are installed on different machines, make sure that
the account:
    - Exists on both machines. For example, it can be a domain user account.
    - Has rights to create databases on the SQL server. The easiest way to ensure this is to include
the account in the Administrators group on the SQL server’s machine before proceeding with
the installation. You can remove the account from this group after the installation is
complete.
- If you choose SQL Server Authentication, specify the login name and password of a SQL server
login account that has rights to create databases on the SQL server.

Registering components on the management server

When installing an Acronis Backup agent or Acronis Backup Storage Node, you need to specify
whether to register these components on Acronis Backup Management Server.

After the agent is registered on the management server, the machine can be centrally managed by
management server administrators. Such a machine is called a registered machine. If you install
another agent at a later time, you will not need to register it.

After the storage node is registered on the management server, registered machines can back up
data to and recover data from the storage node’s centralized vaults.

To register the agent and/or the storage node during installation (recommended)

1. Click Register now.
2. Specify the name or IP address of the machine with the management server. That machine must
be online. It can be the local machine—for example, when the management server is among the
components you are installing.
3. Specify the user name and password of a user who is a member of the Acronis Centralized Admins group on the management server’s machine. If you are installing the management server on the local machine, specify the user name and password of a member of the Administrators group.

**To skip registration**

- Click **I will register the machine later** (or **I will register the components later**).

After the installation, you can register the components on the management server or remove them from it, through the management server’s interface.

**Specifying users allowed to connect remotely**

When installing an agent or the management server (or both), you need to specify the list of users whom you want to allow to manage the machine remotely by using Acronis Backup Management Console.

By default, the list contains all members of the Administrators group on the machine; note that this includes the domain administrators (if the machine is in an Active Directory domain).

The setup program creates the **Acronis Remote Users** group and adds the listed users to it. By adding or removing group members, you will add or remove users who are allowed to connect to the machine remotely.

**2.1.2.3 Web-based installation**

The procedure for Web-based installation is identical to that for interactive installation (p. 20). Web-based installation is available only for Acronis Backup Advanced.

During a Web-based installation, only the components that you are currently installing are downloaded from the Acronis website. You should keep this in mind if you are planning to install components from this machine remotely (p. 45) at a later time. To ensure that all components that can be installed remotely are present on the machine, consider using local installation instead.

When performing Web-based installation on a large number of machines, you may want to avoid multiple downloads of the same component over the Internet. To do this:

1. In your local network, create a shared folder and make it available to all machines where you want to install Acronis Backup.

2. On the first of these machines, do the following:
   a. Run the setup program for Web-based installation.
   b. When selecting the machine roles, select the **I want to manually select the Acronis components...** check box.
   c. When selecting where to install the components, select the **Save the downloaded installation files** check box, and then specify the shared folder that you created.
   d. Proceed with the installation.

   The necessary installation packages will be downloaded to the shared folder.

3. Repeat step 2 on the remaining machines. The setup program will reuse the installation files that are already in the folder, instead of downloading them again. Any other necessary files will be downloaded to the folder.
2.1.2.4 Unattended installation

Components of Acronis Backup, such as Acronis Backup Agent for Windows, can be installed in the unattended mode, as opposed to the interactive mode.

This section describes unattended installation and update by using Windows Installer (the msiexec program). In an Active Directory domain, another way of performing unattended installation or update of a supported component is through Group Policy—see "Installing the agent through Group Policy (p. 29)".

Some components require a file known as a transform (an .mst file). Use of a transform for other components is optional.

The following table summarizes components and features that can be installed or updated in the unattended mode.

<table>
<thead>
<tr>
<th>Component name</th>
<th>msi file name</th>
<th>Requires a transform?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Core (required by any agent)</td>
<td>Agent Core</td>
<td>+</td>
</tr>
<tr>
<td>Agent for Windows (p. 6)</td>
<td>AcronisAgentWindows.msi</td>
<td>+</td>
</tr>
<tr>
<td>Agent for VMware (Windows) (p. 7)</td>
<td>AcronisAgentESX.msi</td>
<td>+</td>
</tr>
<tr>
<td>Agent for Hyper-V (p. 8)</td>
<td>AcronisAgentHyperV.msi</td>
<td>+</td>
</tr>
<tr>
<td>Agent for Exchange (p. 8)</td>
<td>AcronisRecoveryMsExchangeAgent.msi</td>
<td>+</td>
</tr>
<tr>
<td>Agent for SQL (p. 8)</td>
<td>AcronisAgentMsSqlSinglePass.msi</td>
<td>+</td>
</tr>
<tr>
<td>Agent for Active Directory (p. 8)</td>
<td>AcronisAgentADSINGLEPass.msi</td>
<td>+</td>
</tr>
<tr>
<td>Bootable Media Builder (p. 10)</td>
<td>AcronisBootableComponentsMediaBuilder.msi</td>
<td>-</td>
</tr>
<tr>
<td>Management Console (p. 10)</td>
<td>AcronisManagementConsole.msi</td>
<td>-</td>
</tr>
</tbody>
</table>

Preparation

To create a transform for a component, you need the configuration script mst_gen.vbs.

This script is located in the folder where Acronis Backup Management Console is installed. The default folder path is:

- %ProgramFiles%\Acronis\BackupAndRecoveryConsole in 32-bit Windows
- %ProgramFiles(x86)%\Acronis\BackupAndRecoveryConsole in 64-bit Windows

If the management console is installed on a different machine, you can copy the script from that machine. See also “Examples of creating a transform” later in this section.

Order of installation for an agent

When you install an agent, first install the Agent Core component (if it is not yet installed), then the agent itself, and then the agent features.
Installation procedure

To install or update a component in the unattended mode

1. Start the setup program.
2. Click **Extract installation files** (when using the standard setup program) or **Save installation files** (when using the Web-based setup program).
3. Extract the component’s installation package.
4. If you are installing a component that uses a transform, create the transform by running the configuration script. Otherwise, skip this step.

   For example, the following command creates a transform to install Agent for Windows with the license key ABCDE-54321:

   ```
   mst_gen.vbs /msi_path C:\AcronisAgentWindows.msi /serial ABCDE-54321
   ```

   See the examples later in this section. The complete syntax of the configuration script is described in "Configuration script parameters" (p. 32).

5. Do either of the following, depending on whether you are installing or updating the component:

   - If you are installing the component, run Windows Installer (the **msiexec** program) as follows:

     When installing a component that requires a transform (in this example, Agent for Windows):

     ```
     msiexec /i c:\AcronisAgentWindows.msi TRANSFORMS=AcronisAgentWindows.mst /qb
     ```

     Otherwise (in this example, when installing the management console):

     ```
     msiexec /i c:\AcronisManagementConsole.msi /qb
     ```

   - If you are updating the component, run Windows Installer as follows:

     When updating a component that requires a transform (in this example, Agent for Windows):

     ```
     msiexec /i C:\AcronisAgentWindows.msi TRANSFORMS=C:\AcronisAgentWindows.mst ADDLOCAL=ALL /qb
     ```

     Otherwise (in this example, when updating the management console):

     ```
     msiexec /i C:\AcronisManagementConsole.msi ADDLOCAL=ALL /qb /l*v C:\log.log
     ```

Examples of creating a transform

**Transform for Agent Core.** The following command creates a transform for the installation package of the Agent Core component:

```
msiiexec /msi_path C:\AcronisAgentCore.msi /account mydomain\agentuser MyPassWd
/ams_address managementsrv /ams_user adminname AdminPassWd
```

After unattended installation with this transform:

- The agents’ service will run under the **agentuser** domain user account (of the **mydomain** domain) whose password is **MyPassWd**.
- The agents will be registered on Acronis Backup Management Server installed on the **managementsrv** machine; **adminname** and **AdminPassWd** are respectively the user name and password of a management server administrator.

**Transform for Agent for Windows.** The following command creates a transform for the installation package of Agent for Windows:

```
msiiexec /msi_path C:\AcronisAgentWindows.msi /license_server licensesrv /product AS
```

After unattended installation with this transform:
The agent will use a license for Acronis Backup Advanced for Windows Server, by taking it from the license server installed on the licensesrv machine.

Similarly, you can create transforms for the agent features.

2.1.2.5 Update

To update one or more Acronis Backup components:
1. Run the setup program of the updated version of Acronis Backup.
2. Click Install Acronis Backup.
3. Click Update.
4. If prompted, specify the license keys, by typing them manually or by specifying the license server.
5. Follow the on-screen instructions.

Updating components in the unattended mode

For information about updating a component in the unattended mode, see "Unattended installation (p. 27)".

2.1.3 Installing the agent through Group Policy

You can centrally install (or deploy) Acronis Backup Agent for Windows onto machines that are members of an Active Directory domain, by using Group Policy.

In this section, you will find out how to set up a Group Policy object to deploy Acronis Backup Agent for Windows onto machines in an entire domain or in its organizational unit.

Every time a machine logs on to the domain, the resulting Group Policy object will ensure that the agent is installed on the machine.

2.1.3.1 Prerequisites

Before proceeding with agent deployment, make sure that:

- You have an Active Directory domain with a domain controller running Microsoft Windows Server 2003 or later.
- You are a member of the Domain Admins group in the domain.
- You know the license key or the name or IP address of a machine where Acronis License Server is installed.
- You have a machine running Windows, with Acronis Backup Management Console installed on the machine.

2.1.3.2 Preparing the agent’s deployment

Step 1: Extracting installation packages

You need to create a shared folder that will contain the installation packages (provided as .msi files), and extract the packages there.

1. On the domain controller (or any other machine in the domain), create a folder—for example: D:\Acronis
2. Start the Acronis Backup setup program.
3. Click Extract installation files.
4. Select the **Agent for Windows** (AcronisAgentWindows.msi) and **Agent Core** (AcronisAgentCore.msi) check boxes.

5. In **Extract to**, type the name of the folder that you just created, or click **Browse** and select the folder.

6. Click **Extract**.

7. Share the folder where you placed the installation packages. Make sure that domain users can access the shared folder—for example, by leaving the default sharing settings for **Everyone**.

**Step 2: Configuring the installation packages**

*Important: Skip this step when reinstalling or updating the agent.*

You need to configure the installation packages of the Agent Core and Agent for Windows components by running the configuration script. The script is installed along with the management console. By default, the script is located in the folder `%ProgramFiles%\Acronis\BackupAndRecoveryConsole` or `%ProgramFiles(x86)%\Acronis\BackupAndRecoveryConsole`. If the management console is installed on a different machine, you can copy the configuration script from that machine.

The configuration script creates a transform (also known as a modification, a modification file, or an .mst file) for an installation package.

1. In the **Start** menu, click **Run**, and then type: `cmd`

2. Click **OK**.

3. Change the current folder to the one where the configuration script `mst_gen.vbs` is located, by running commands such as:

   ```
   C: cd "C:\Program Files\Acronis\BackupAndRecoveryConsole"
   ```

4. Run the configuration script for the Agent Core and for the Agent for Windows components; for example, as follows:

   ```
   mst_gen.vbs /msi_path D:\Acronis\AcronisAgentCore.msi
   mst_gen.vbs /msi_path D:\Acronis\AcronisAgentWindows.msi /license_server licensesrv /product AS
   ```

   *Note: You must include a complete path to the installation package, even if the package is in the same folder as the configuration script.*

   For the complete syntax of the configuration script, see "Configuration script parameters" (p. 32). See also "Examples of creating a transform" in "Unattended installation" (p. 27).

The installation packages are ready for deployment. You now need to create Group Policy objects, as described in "Setting up the Group Policy objects" (p. 30).

### 2.1.3.3 Setting up the Group Policy objects

Use this procedure to set up a Group Policy object (GPO) for agent deployment in the entire domain or in its organizational unit. The agent will be installed on each machine which is a member of the domain or the organizational unit immediately after Windows starts on that machine.

**Prerequisites**

- You must be logged on to the domain controller as a domain administrator; if the domain has more than one domain controller, log on to any of them as a domain administrator.
If you are planning to deploy the agent in an organizational unit, make sure that the organizational unit exists in the domain.

Make sure that you have completed the steps described in Preparing the agent's deployment (p. 29).

Step 1: Creating Group Policy objects
2. In Windows Server 2003:
   - Right-click the name of the domain or organizational unit, and then click Properties. In the dialog box, click the Group Policy tab, and then click New.
     - Right-click the name of the domain or organizational unit, and then click Create a GPO in this domain, and Link it here.
3. Name the new Group Policy object Acronis Agent
4. Similarly, create another Group Policy object and name it Acronis Core
5. Ensure that the Acronis Agent object is higher in the list than the Acronis Core object.

Step 2: Configuring the Group Policy object for the agent
1. Open the Acronis Agent Group Policy object for editing, as follows:
   - In Windows Server 2003:
     - Click the Group Policy object, and then click Edit.
     - Under Group Policy Objects, right-click the Group Policy object, and then click Edit.
2. In the Group Policy object editor snap-in, expand Computer Configuration.
3. In Windows Server 2003 and Windows Server 2008:
   - Expand Software Settings.
   - In Windows Server 2012 and Windows Server 2016:
     - Expand Policies > Software Settings.
4. Right-click Software installation, then point to New, and then click Package.
5. Select the agent's installation package in the shared folder that you previously created, and then click Open.
6. In the Deploy Software dialog box, click Advanced, and then click OK.
7. If you are reinstalling or updating the agent, do nothing.
   - If you are installing the agent, do the following:
     - On the Modifications tab, click Add, and then select the transform that you previously created; the transform file has the name AcronisAgentWindows.mst and is located in the same folder as the agent's installation package.
8. Click OK to close the Deploy Software dialog box.

Step 3: Configuring the Group Policy object for the Agent Core component
1. Open the Acronis Core Group Policy object for editing, as follows:
   - In Windows Server 2003:
     - Click the Group Policy object, and then click Edit.
Under **Group Policy Objects**, right-click the Group Policy object, and then click **Edit**.

2. In the Group Policy object editor snap-in, expand **Computer Configuration**.

3. In Windows Server 2003 and Windows Server 2008:
   - Expand **Software Settings**.
     - In Windows Server 2012 and Windows Server 2016:
       - Expand **Policies > Software Settings**.

4. Right-click **Software installation**, then point to **New**, and then click **Package**.

5. Select the **AcronisAgentCore.msi** installation package in the shared folder that you previously created, and then click **Open**.

6. In the **Deploy Software** dialog box, click **Advanced**, and then click **OK**.

7. If you are reinstalling or updating the agent, do nothing.
   - If you are installing the agent, do the following:
     - On the **Modifications** tab, click **Add**, and then select the transform that you previously created; the transform file has the name **AcronisAgentCore.mst** and is located in the same folder as the component's installation package.

8. Click **OK** to close the **Deploy Software** dialog box.

### 2.1.4 Configuration script parameters

The configuration script **mst_gen.vbs** creates an .mst file (known as a transform, a modification, or a modification file) for the installation package of an Acronis component such as Acronis Backup Agent for Windows.

By using the transform together with the installation package, you can install the component in the unattended mode either by running the installation package manually or by deploying it through Group Policy.

The following is the complete syntax of the configuration script:

```vbs
mst_gen.vbs
   /msi_path <Full path>
   [/target_dir <Installation folder>]
   [/account <User name> <Password>]
   [/remote_users <User1>;<User2>;...;<UserN>]
   [/ams_address <Management server> /ams_user <Administrator name> <Password>]
   [/cep_enabled]
   [/serial <License key> [/old_serial <old license key>] | /license_server <License server> /product <Product code>]
   [/current_user]
```

Brackets ([ ]) denote parameters that are optional or that apply only to some components. Braces ({ }) denote mutually exclusive sets of parameters; each set is separated by a pipe (|).

The following is the description of each parameter and the list of components it applies to.

**Parameters that apply to any component**

`/msi_path <Full path>`
Specifies a full path to the component's installation package. Enter a local path, such as D:\folder\AcronisAgentWindows.msi; or enter a universal naming convention (UNC) path, such as \server\folder\AcronisAgentWindows.msi.

/target_dir <Installation folder>

Specifies the folder where to install the component.
Without this parameter, the component will be installed to the default folder: %ProgramFiles%\Acronis (in a 32-bit version of Windows) or %ProgramFiles(x86)%\Acronis (in a 64-bit version of Windows).

Parameter that applies only to the Agent Core and Management Console components

The following parameter applies only to the installation packages AcronisAgentCore.msi and AcronisManagementConsole.msi.

/cep_enabled

Specifies whether a machine with any of these components will participate in the Acronis Customer Experience Program (CEP).

With this parameter, information about the hardware configuration, about the most and least used features, and about any problems will be automatically collected from the machine and sent to Acronis on a regular basis. The kind of information to be sent depends on which of the above components will be installed on the machine. The terms of participation can be found on the Customer Experience Program webpage.

Without this parameter, the information will not be sent.

Parameters that apply only to the Agent Core component

The following parameters apply only to the installation package AcronisAgentCore.msi.

/account <User name> <Password>

Specifies the user name and password of the user account under which Acronis Managed Machine Service will run on the machine. All agents on the machine will run as this service. The user account must have appropriate privileges as described in "Specifying credentials for Acronis services" (p. 23). Separate the name of the domain and the account by a backslash, as in:

mydomain\User.

Without this parameter, the service will run under the default account: Acronis Agent User.

/remote_users <User1>;<User2>;...;<UserN>

Specifies the user names that will be added to the Acronis Remote Users group. Members of this group are allowed to connect to the machine remotely.

With this parameter, only the specified users will be added to the group. Separate the user names by using semicolons (;).

Without this parameter, all members of the Administrators group on the particular machine will be added to the group.

/ams_address <Management server>

Specifies the name or IP address of Acronis Backup Management Server. With this parameter, the machine will be registered on the management server after the installation is complete.

/ams_user <Administrator name> <Password>

Specifies the name and password of a user who is a member of the Acronis Centralized Admins group on the management server. Use this parameter with the /ams_address parameter.
Parameters that apply only to a component that requires a license

The following parameters apply only to the installation packages AcronisAgentWindows.msi, AcronisAgentESX.msi, and AcronisAgentHyperV.msi.

/serial <License key>

Specifies the license key to use when installing the component. A license key is a sequence of letters and numerals separated by dashes. Enter the license key exactly, including the dashes.

/old_serial <old license key>

When upgrading from Acronis Backup & Recovery 10 or 11, this parameter specifies the license key for that product. Use this parameter with the /serial parameter.

If the license keys are stored on a license server, use the /license_server parameter instead.

/license_server <License server>

Specifies the name or IP address of the machine where the license server is installed.

When using this parameter, also specify the /product parameter.

/product <Product code>

Specifies the code of your product.

The codes are the following:
Acronis Backup Advanced for Windows Server: ABR11.5_ASW
Acronis Backup for Windows Server Essentials: ABR11.5_SBS
Acronis Backup Advanced for PC: ABR11.5_AW
Acronis Backup Advanced Universal License: ABR11.5_VE
Acronis Backup Advanced for Hyper-V: ABR11.5_VEHV
Acronis Backup Advanced for VMware: ABR11.5_VEESX
Acronis Backup Advanced for RHEV: ABR11.5_VERHEV
Acronis Backup Advanced for Citrix XenServer: ABR11.5_VEXEN
Acronis Backup Advanced for Oracle VM: ABR11.5_VEORCL
Acronis Backup Advanced for SQL: ABR11.5_SQL
Acronis Backup Advanced for SharePoint: ABR11.5_SP
Acronis Backup Advanced for Active Directory: ABR11.5_AD.

Note: If neither the /serial parameter nor the /license_server parameter is specified, the component will be installed for cloud backup only.

Parameter that applies only to the Management Console component

The following parameter applies only to the installation package AcronisManagementConsole.msi.

/current_user

Specifies that the component will be installed for the current user only and not for all users on a machine.

Avoid using this parameter when installing the component through Group Policy, because the “current user” in such installation is typically a system account.

2.1.5 Installation from the management server Web page

Acronis Backup Management Server comes with its own Web server and Web page. You or users in your organization can go to that Web page from any machine with a supported Web browser (p. 35),
and install Acronis Backup without having to specify installation settings. When installing an agent, the setup program registers the machine on the management server.

The Web page enables access to installation packages in a network that does not allow sharing folders.

Unlike installation through Group Policy (p. 29), installation from the Web page can be started by the user. It can be performed on machines that are not members of a domain, including machines running Linux.*

Unlike remote installation (p. 45), which is often blocked by a firewall, installation from the Web page does not require any non-standard network ports to be open. A port for HTTP (by default, port 8080) is used for installation.

For the Web page to work, the Components for Remote Installation component must be installed. When installing the management server, check the summary page to make sure that this component is among the components to install. You can specify the folder where to place the installation packages.

*To add a component for Linux to the Web page, download this component from the Acronis website. Then add the corresponding installed-products element to the configuration file described in "Changing installation settings" (p. 36). This will make the component’s installation file accessible via the Web page. Other settings of the configuration file will be ignored in Linux. You need to specify installation settings manually during every installation.

2.1.5.1 Supported Web browsers

The Web page can be accessed from any of these Web browsers:

- Internet Explorer 6 or later
- Mozilla Firefox 3.6 or later
- Safari 5 or later
- Google Chrome 6 or later
- Opera 10.6 or later

*Important: Make sure that JavaScript is enabled in the browser.*

2.1.5.2 Using the management server Web page

To open the management server Web page, type the name or IP address of the management server’s machine and the port number in the browser’s address bar. For example, type http://ams:8080 or http://192.168.0.1:8080

If the Web page must be accessed through a non-default port, specify that port instead of 8080.

Installation with pre-selected components

The following is how you can use the Web page to enable users in your organization to easily install Acronis Backup on their machines:

1. You go to the Web page. It displays the list of components of Acronis Backup that a user can install.
2. You select one or more components that the users need to install.
3. You copy the Download link and send it to the users.
4. A user follows the link and starts the setup program.
5. The setup program runs with all required fields (such as the name of the license server) already filled in. The user can go through the installation wizard without changing any settings.

**Installation with selecting components on-site**

The following is how advanced users can use the Web page to easily install Acronis Backup on their machines:

1. A user goes to the Web page. It displays the list of components of Acronis Backup that the user can install.
2. The user selects one or more components to install.
3. The user clicks the Download button.
4. The user starts the setup program.
5. The setup program runs with all required fields (such as the name of the license server) already filled in. The user can go through the installation wizard and change any settings if necessary.

**How installation works**

The setup program itself is small in size. It downloads the installation packages of the selected components from the management server’s machine.

When installing an agent in Windows, the setup program will create a dedicated user account for the agent’s service.

2.1.5.3 Default installation settings

The setup program takes installation settings from the configuration file, which is stored on the management server’s machine.

The default settings in the configuration file are the following:

- To use the license server that comes with the management server. Each agent being installed will acquire its own license from that license server.
- To install the components to the following folder:
  - In 32-bit versions of Windows: %ProgramFiles%\Acronis
  - In 64-bit versions of Windows: %ProgramFiles(x86)%\Acronis
  - In Linux: /usr/lib/Acronis (this setting cannot be changed)

For information about how to change the default settings, see "Changing installation settings" (p. 36).

2.1.5.4 Changing installation settings

To change the default installation settings, you need to edit the configuration file.

The name of the configuration file is **settings.xml**. The file is stored on the machine where the management server is installed. The file is located in the **WebPage** subfolder of the installation folder you specified. By default:

- When installed in a 32-bit version of Windows: %ProgramFiles%\Acronis\WebPage
- When installed in a 64-bit version of Windows: %ProgramFiles(x86)%\Acronis\WebPage

This file stores settings in the following elements:

**installed-products**
Specifies what components appear on the Web page. Each component is specified as a **product** element. For example:

```xml
<product
    name="Agent for Windows"
    package="AcronisAgentWindows.msi"
    type="win"
    description="Install the agent on a machine to be able to back up its disks, volumes and files."
/>
```

The **product** element has the following attributes:

- **name**
  The name of the component as it appears on the Web page.

- **package**
  The name of the component’s installation package (an .msi, .i686, or .x86_64 file). The file must be located in the following folder:
  `%CommonProgramFiles%\Acronis\RemoteInstaller\<product build number>`.

- **type**
  The operating system for which the component is intended. The possible values of this attribute: **win** (Windows) and **linux** (Linux).

- **description**
  The description of the component as it appears on the Web page. The description is shown under the name of the component.

- **ams**
  Specifies the management server (AMS) on which the machine will be registered after installation. For example:

  ```xml
  <ams address="ManagementServer" />  
  ```

  The **address** attribute specifies the name or IP address of the management server. This must be the same server where the Web page is installed. Do not try to specify another server here. However, you can change the network name of the server to its fully-qualified domain name (FQDN), such as ManagementServer.example.com, or to its IP address. This may be useful if the downloaded setup program fails to add user machines to the management server.

- **license-server**
  Specifies the license server from which components will take licenses during installation. For example:

  ```xml
  <license-server address="LicenseServer" />  
  ```

  The **address** attribute specifies the name or IP address of the license server.

- **web-setup-settings**
  Specifies how the components will be installed. This element has the following content:

  - **acep**
    Specifies whether to enable the machine to participate in the Acronis Customer Experience Program (CEP). The default setting is:

    ```xml
    <acep enabled="false" />  
    ```
The possible values of the `enabled` attribute: `true` (participation is enabled) and `false` (participation is not enabled).

**install**

Specifies for which Windows users to install the components and how much interaction is required from the user during installation. The default setting is:

```xml
<install for_user="all" mode="manual" />
```

The possible values of the `for_user` attribute: `all` (to install the components for all Windows users on the machine) and `current` (to install the components only for the Windows user who started the setup program).

The `mode` attribute is reserved for use in future versions. Its only possible value now is `manual`. With this value, the setup program runs will all required fields already filled in, but the user still must go through the installation wizard.

**installation-path**

Specifies where to install the components.

This element has the following content:

-x86

Specifies where to install the components on machines running 32-bit versions of Windows.

-x64

Specifies where to install the components on machines running 64-bit versions of Windows.

In both elements, the `path` attribute specifies the path. The default settings are:

```xml
<x86 path="%ProgramFiles%/Acronis" />
<x64 path="%ProgramFiles(x86)%/Acronis" />
```

Components for Linux are always installed to the `/usr/lib/Acronis` directory.

### 2.1.5.5 Changing the port for the Web page

By default, the Web page is available through port 8080. If another program already uses this port, you will need to specify a different port.

The port number is shown on the summary screen when you install the management server. To be able to change the port number, select the **I want to manually select the Acronis components...** check box in the machine role selection window. Then, specify the port in the corresponding window.

If the management server is already installed, you can change the port number by reconfiguring the Web server, as follows:

1. Open the `httpd.conf` file, which is located in the following folder:
   - In a 32-bit version of Windows: `%CommonProgramFiles%\Acronis\WebServer\conf`
   - In a 64-bit version of Windows: `%CommonProgramFiles(x86)%\Acronis\WebServer\conf`

2. Change the value of the `Listen` setting to the desired port number. For example, the setting `Listen 8888` means using port 8888 for the Web page.

   **Important:** Do not specify the port through which the management server communicates with other components of Acronis Backup. By default, this is port 9876.

3. Restart the service of the Web server. You can do this in either of these ways:
   - At the command prompt by running the following commands:
net stop "Acronis Web Server Service"
net start "Acronis Web Server Service"

- In the Services snap-in by right-clicking Acronis Web Server Service and then clicking Restart.

2.1.6 Installing Acronis License Server

The license server is integrated with Acronis Backup Management Server. We recommend using that license server.

If you need to install the license server as a separate component, use the following procedure.

To install the license server as a separate component

1. Start the setup program.
2. Click Install Acronis Backup.
3. Accept the terms of the license agreement.
4. Select the I want to manually select the Acronis components... check box, and then click Next.
5. In the list of components, under Other components, select the License Server check box, and then click Next.
   - Click Import from file and specify the file containing the list of license keys. You can specify multiple files one by one or enter the license keys manually.
   - Details. You will be able to import additional license keys later at any moment (including when installing the agents), by specifying a file containing the keys or by typing them in manually.
6. Use the default values for Install to: and Install for:
7. Proceed with installation.

2.2 Installation in Linux

This section describes installation of Acronis Backup components on a machine running Linux.

By using command-line parameters, you can install the product in the unattended installation mode.

2.2.1 Preparation

This section describes preparatory steps for installation in Linux.

2.2.1.1 RPM Package Manager

Make sure that the RPM Package Manager (RPM) is installed in your system. Before installing the product on a Linux distribution that does not use RPM, such as Ubuntu, you need to install RPM manually; for example, by running the following command:

```
sudo apt-get install rpm
```

Linux distributions where RPM is already installed include Red Hat Enterprise Linux, Fedora, and SUSE Linux Enterprise Server.

2.2.1.2 Linux packages

To add the necessary modules to the Linux kernel, the setup program needs the following Linux packages:

- The package with kernel headers or sources. The package version must match the kernel version.
The GNU Compiler Collection (GCC) compiler system. The GCC version must be the one with which the kernel was compiled.
- The Make tool.
- The Perl interpreter.

The names of these packages vary depending on your Linux distribution.

In Red Hat Enterprise Linux, CentOS, and Fedora, the packages normally will be installed by the setup program. In other distributions, you need to install the packages if they are not installed or do not have the required versions.

**Are the required packages already installed?**

To check whether the packages are already installed, perform these steps:

1. Run the following command to find out the kernel version and the required GCC version:
   ```
   cat /proc/version
   ```
   This command returns lines similar to the following: Linux version 2.6.35.6 and gcc version 4.5.1

2. Run the following command to check whether the Make tool and the GCC compiler are installed:
   ```
   make -v
gcc -v
   ```
   For gcc, ensure that the version returned by the command is the same as in the gcc version in step 1. For make, just ensure that the command runs.

3. Check whether the appropriate version of the packages for building kernel modules is installed:
   - In Red Hat Enterprise Linux, CentOS, and Fedora, run the following command:
     ```
     yum list installed | grep kernel-devel
     ```
   - In Ubuntu, run the following commands:
     ```
     dpkg --get-selections | grep linux-headers
dpkg --get-selections | grep linux-image
     ```
   In either case, ensure that the package versions are the same as in Linux version in step 1.

4. Run the following command to check whether the Perl interpreter is installed:
   ```
   perl --version
   ```
   If you see the information about the Perl version, the interpreter is installed.

**Installing the packages from the repository**

The following table lists how to install the required packages in various Linux distributions.

<table>
<thead>
<tr>
<th>Linux distribution</th>
<th>Package names</th>
<th>How to install</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Hat Enterprise Linux</td>
<td>kernel-devel gcc-devel gcc make perl make</td>
<td>The setup program will download and install the packages automatically by using your Red Hat subscription. Run the following command: yum install perl</td>
</tr>
<tr>
<td>CentOS Fedora</td>
<td>kernel-devel gcc-devel gcc make</td>
<td>The setup program will download and install the packages automatically.</td>
</tr>
<tr>
<td>perl</td>
<td>Run the following command:</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>----------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>yum install perl</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ubuntu</th>
<th>linux-headers</th>
<th>Run the following commands:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>linux-image</td>
<td>sudo apt-get update</td>
</tr>
<tr>
<td></td>
<td>gcc</td>
<td>sudo apt-get install linux-headers-<code>uname -r</code></td>
</tr>
<tr>
<td></td>
<td>make</td>
<td>sudo apt-get install linux-image-<code>uname -r</code></td>
</tr>
<tr>
<td></td>
<td>perl</td>
<td>sudo apt-get install gcc-&lt;package version&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sudo apt-get install make</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sudo apt-get install perl</td>
</tr>
</tbody>
</table>

The packages will be downloaded from the distribution's repository and installed.

For other Linux distributions, please refer to the distribution's documentation regarding the exact names of the required packages and the ways to install them.

**Installing the packages manually**

You may need to install the packages manually if:

- The machine does not have an active Red Hat subscription or Internet connection.
- The setup program cannot find the kernel-devel or gcc version corresponding to the kernel version. If the available kernel-devel is more recent than your kernel, you need to either update the kernel or install the matching kernel-devel version manually.
- You have the required packages on the local network and do not want to spend time for automatic search and downloading.

Obtain the packages from your local network or a trusted third-party website, and install them as follows:

- In Red Hat Enterprise Linux, CentOS, or Fedora, run the following command as the root user:
  ```bash
rpm -ivh PACKAGE_FILE1 PACKAGE_FILE2 PACKAGE_FILE3
  ```
- In Ubuntu, run the following command:
  ```bash
  sudo dpkg -i PACKAGE_FILE1 PACKAGE_FILE2 PACKAGE_FILE3
  ```

**Example: Installing the packages manually in Fedora 14**

Follow these steps to install the required packages in Fedora 14 on a 32-bit machine:

1. Run the following command to determine the kernel version and the required GCC version:
   ```bash
cat /proc/version
  ```
   The output of this command includes the following:
   ```bash
   Linux version 2.6.35.6-45.fc14.i686
gcc version 4.5.1
  ```
2. Obtain the kernel-devel and gcc packages that correspond to this kernel version:
   ```bash
   kernel-devel-2.6.35.6-45.fc14.i686.rpm
gcc-4.5.1-4.fc14.i686.rpm
  ```
3. Obtain the make package for Fedora 14:
   ```bash
   make-3.82-3.fc14.i686
  ```
4. Install the packages by running the following commands as the root user:
   ```bash
   rpm -ivh kernel-devel-2.6.35.6-45.fc14.i686.rpm
   rpm -ivh gcc-4.5.1-4.fc14.i686.rpm
   rpm -ivh make-3.82-3.fc14.i686
  ```
You can specify all these packages in a single `rpm` command. Installing any of these packages may require installing additional packages to resolve dependencies.

### 2.2.1.3 Installation files

Download the installation files and assign them necessary access permissions:

1. Go to the Acronis website.
2. Download the installation file (when installing Acronis Backup) or files (when installing Acronis Backup Advanced). Depending on the machine platform (x86 or x86_64), you need either the .i686 or .x86_64 files.
3. Copy the installation files to a directory on the machine where you want to install the product.
4. Go to the directory where you copied the installation files, and then run the following command:

   ```bash
   chmod 755 AcronisBackup*
   ```

### 2.2.2 Interactive installation of Acronis Backup Advanced

**To install Acronis Backup Agent for Linux**

1. Ensure that you have a license for Acronis Backup Advanced. You can import the licenses to the Acronis License Server.

   To install the agent in the trial mode (p. 4) or for cloud backup only, you do not need licenses.

2. Run the appropriate installation file (an .i686 or an .x86_64 file) as the root user.
3. Accept the terms of the license agreement.
4. Do either of the following:
   - To install the product in the trial mode, select **Install in trial mode**.
   - To install the product for cloud backup only, select **Install for cloud backup only**.
   - To install the product in the full mode, specify the license keys in either of these ways:
     - Select **Select Acronis License Server**, and then type the name or IP address of the license server.
     - Select **Enter the license key**, and then type your Acronis Backup Advanced license key.
5. Specify whether you want to register the machine on the management server. You can add the machine to the management server later by using the machine’s name or IP address.
6. If you install the software in Red Hat Enterprise Linux or CentOS, the setup program may notify you about the absence of some of the required Linux packages. Select **Continue** to try to install these packages automatically (recommended), or select **Skip** to skip the package installation. For more detailed information about the required packages, see the "Linux packages" (p. 39) section.
7. The setup program tries to automatically compile the SnapAPI module for your Linux kernel. If it fails to do so, please refer to the file: `usr/lib/Acronis/BackupAndRecovery/HOWTO.INSTALL`.

**To install Acronis Backup Management Console or Acronis Bootable Media Builder**

1. Run the installation file of the management console or bootable media builder (an .i686 or an .x86_64 file) as the root user.
2. Follow the on-screen instructions.

### 2.2.3 Installation in the unattended mode

To install a component in the unattended mode (without asking for confirmations), run the component’s installation file with the `-a` command-line parameter. You may need to use other parameters (p. 43) to specify how to perform the installation.
The following are two examples of unattended installation. These examples assume that you are using a 32-bit installation file (.i686). The same parameters work with a 64-bit installation file (.x86_64).

**Example 1: Unattended installation with a license key.**

The following command installs Acronis Backup in the unattended mode and uses the license key 12345-67890-ABCDE:

```
./AcronisBackupL.i686 -a -l 12345-67890-ABCDE
```

You can use the same parameters to install Agent for Linux from the corresponding Acronis Backup Advanced installation file.

**Example 2: Unattended installation with a license server.**

This example applies only to Acronis Backup Advanced.

The following command:

- Installs Agent for Linux in the unattended mode.
- Uses an Acronis Backup Advanced for Linux Server license; the license key is stored on the Acronis License Server that is located on the machine `licensesrv`.
- Once the installation is complete, registers the machine on the management server located on the machine `managementsrv`.

```
./AcronisBackupAdvancedAgentL.i686 -a -L licensesrv -P ABR11.5_ASL -C managementsrv -g srvadmin -w PassWd123
```

### 2.2.4 Command-line parameters

When running the installation files of Acronis Backup, you can specify one or more of command-line parameters.

#### Common parameters

Unless stated otherwise, the parameters are present in all installation files.

- **-a** or **--auto**
  - Performs installation in the so-called unattended setup mode, as opposed to the default interactive mode.
  - The setup program will proceed without asking for interaction, such as typing the license key or clicking the Next buttons.
  - When using this parameter, you need to specify the component to install, by using the **-i** parameter.
  - When running the installation file of Acronis Backup Agent for Linux, you also need to specify the license server or the license key by using the **-L** or **-l** parameter, respectively.
  - If the SnapAPI module needs to be compiled and the compilation is possible, the setup program will automatically compile the module; otherwise, it will skip the compilation.

- **-n** or **--nodeps**
  - Ignores dependencies during an unattended setup (see the **-a** parameter described previously).
  - With this parameter, the setup will proceed even if the packages necessary for the software to work are not installed. If any dependencies are missing, software functionality will be limited.
-u or --uninstall

Uninstalls the component. You do not need to specify a license key or the license server.

-s or --disable-native-shared

Forces using the setup program’s own redistributable libraries during installation, instead of those present in the system.

Redistributable libraries are standard sets of internal tools. Programs use these libraries for purposes such as displaying the user interface.

The setup program contains copies of all the libraries it needs. By default, it uses a copy of a library only when no such library is present in the system. With this parameter, the setup program always uses the copy.

You may want to use this parameter when experiencing problems with installation; for example, when the user interface of the setup program is not displayed correctly.

-d or --debug

Puts verbose information to the installation log.

-i <Component name> or --id=<Component name>

Applies only to installation of Acronis Backup. In Acronis Backup Advanced, each component is installed from a separate installation file.

Specifies the name of the component being installed:

- For Acronis Backup Agent for Linux: BackupAndRecoveryAgent
- For Acronis Backup Bootable Components and Media Builder: BackupAndRecoveryBootableComponents
- For Acronis Backup Management Console: ManagementConsole

The names are case-sensitive.

-v or --version

Displays the product version and then exits.

-? or --help

Displays help and then exits.

--usage

Displays a brief usage message and then exits.

Parameters that apply only to the installation file of Acronis Backup Agent for Linux

-e {0|1} or --ssl={0|1}

Specifies whether to enable authentication for connection to other components. Authentication is performed by using Secure Socket Layer (SSL) certificates.

The possible values are:

0: Do not use authentication
1: Use authentication

-C <Management server> or --ams=<Management server>

Specifies the name or IP address of the Acronis Backup Management Server.

When using this parameter, you need to specify the user name and password of a management server administrator by using the -g and -w parameters, respectively.
The machine will be registered on the management server after the installation is complete.

-\texttt{g <User name> or \--login=<User name>}

Specifies the user name of a member of the \textit{Acronis Centralized Admins} group on the management server whose name is given by \texttt{<Management server>}. \texttt{-w <Password> or \--password=<Password>}

Specifies the password for the user whose name is given by \texttt{<User name>}. \texttt{-p <Port number> or \--port=<Port number>}

Specifies the number of the TCP port to use to connect to other Acronis Backup components. The default port number is 9876.

**Parameters that determine the installation mode**

- To install the component in the trial mode, use the \texttt{-T} parameter.
- To install the component in the full mode, use either the \texttt{-l} or \texttt{-L} parameter.
- To install the component for cloud backup only, do not specify any of these parameters.

\texttt{-T or \--trial}

Installs the component in the trial mode.

\texttt{-l <License key> or \--serial=<License key>}

Specifies the license key for the component.

\texttt{-L <License server> or \--license-server=<License server>}

Specifies the name or IP address of the Acronis License Server.

When using this parameter, you need to specify the code of your product, by using the \texttt{-P} parameter.

\texttt{-P <Product alias>}

Specifies the product code of Acronis Backup—also called the product alias. The codes are the following:

- Acronis Backup Advanced for Linux Server: \texttt{ABR11.5_ASL}
- Acronis Backup Advanced Universal License: \texttt{ABR11.5_VE}
- Acronis Backup Advanced for VMware: \texttt{ABR11.5_VEESX}
- Acronis Backup Advanced for Hyper-V: \texttt{ABR11.5_VEHV}
- Acronis Backup Advanced for RHEV: \texttt{ABR11.5_VERHEV}
- Acronis Backup Advanced for Citrix XenServer: \texttt{ABR11.5_VEXEN}
- Acronis Backup Advanced for Oracle VM: \texttt{ABR11.5_VEORCL}

### 2.3 Remote installation

Components of Acronis Backup, such as Agent for Windows and Agent for Linux, can be installed remotely to one or more machines running the corresponding operating systems.

To perform remote installation, you need administrative privileges on the target machines.

You can perform remote installation in any of these ways:

- From the management console installed on a machine running Windows.
- When adding one or more machines to the management server.
2.3.1 Prerequisites

Management console

You need the management console installed on a machine running Windows.

Installation packages

Components are installed from installation packages. By default, the software takes these packages from the folder %CommonProgramFiles%\Acronis\RemoteInstaller\<product build number>. If the console is connected to the management server, the software will take the packages from the machine with the management server. Otherwise, the software will take the packages from the machine with the console.

If the installation packages are not present in this folder (or in another folder that you will be able to specify during the installation), get them as follows.

How to get packages for Windows

1. Start the Acronis Backup setup program on the machine from which the packages are to be taken by the software. The setup file must be in a local folder.
2. Click Install Acronis Backup.
3. Accept the terms of the license agreement.
4. Click Modify.
5. Select the Components for Remote Installation check box and click Next.
6. Follow the on-screen instructions.

How to get packages for Linux

Download the required installation files (.i686 or .x86_64) from the Acronis website and put them on the machine from which they are to be taken by the software.

If you are planning to install Acronis components on both Windows and Linux machines, put the packages for Linux into the directory where the packages for Windows are. This will help you configure installation of Acronis components on Windows and Linux machines at the same time.

2.3.2 Preparation

On machines running Windows

1. Make sure that the machines meet the system requirements (p. 16).
2. For successful installation on a remote machine running Windows XP, the option Control panel > Folder options > View > Use simple file sharing must be disabled on that machine.
   For successful installation on a remote machine running Windows Vista or later, the option Control panel > Folder options > View > Use Sharing Wizard must be disabled on that machine.
3. For successful installation on a remote machine that is not a member of an Active Directory domain, User Account Control (UAC) must be disabled (p. 47).
4. File and Printer Sharing must be enabled on the remote machine. To access this option:
   - On a machine running Windows XP with Service Pack 2 or Windows 2003 Server: go to Control panel > Windows Firewall > Exceptions > File and Printer Sharing.
5. Acronis Backup uses TCP ports 445 and 25001 for remote installation. Also, it uses TCP port 9876 for remote installation and for communication between the components. Port 445 is automatically opened when you enable File and Printer Sharing. Ports 9876 and 25001 are automatically opened through Windows Firewall. If you use a different firewall, make sure that these three ports are open (added to exceptions) for both incoming and outgoing requests.

After the remote installation is complete, you can remove ports 445 and 25001 from exceptions. Port 25001 is automatically closed through Windows Firewall. Port 9876 needs to remain open.

On machines running Linux
1. Make sure that the machines meet the system requirements (p. 16).
2. Check that each of the machines meets the prerequisites for local installation of Agent for Linux (p. 39), except for the "Installation files" step.
3. Make sure that TCP port 22 is opened and that the SSH daemon is running on each of the machines. After the remote installation is complete, you can close the port and stop the SSH daemon.
4. Open TCP port 9876 on each of the machines. Acronis Backup uses this port for communication between the components; therefore, it must remain open for both incoming and outgoing requests.

2.3.2.1 Requirements on User Account Control (UAC)

On a machine that is running Windows Vista or later and is not a member of an Active Directory domain, centralized management operations (including remote installation) require that UAC be disabled.

To disable UAC

Do one of the following depending on the operating system:

- **In a Windows operating system prior to Windows 8:**
  Go to Control panel > View by: Small icons > User Accounts > Change User Account Control Settings, and then move the slider to Never notify. Then, restart the machine.

- **In any Windows operating system:**
  1. Open Registry Editor.
  2. Locate the following registry key: `HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\System`
  3. For the `EnableLUA` value, change the setting to 0.
  4. Restart the machine.

2.3.3 Installation procedure

Do the following to install components of Acronis Backup remotely:

1. Start the remote installation in any of these ways:
   - **From the management console:** Start the management console. On the Tools menu, click Install Acronis components.
   - **When adding one or more machines to the management server:** Connect the management console to the management server. On the Actions menu, click Add a machine to AMS or Add multiple machines.
2. Specify the machines where the components are to be installed (p. 48). When adding a single machine to the management server, just specify that machine's name or IP address, and the credentials of an account with administrative privileges on that machine.

3. Specify the components that you want to install (p. 49).

4. If prompted, specify one or more of the following parameters depending on your component selection:
   - Installation mode (with or without license keys) (p. 50).
   - Installation options:
     - Credentials for the agent service (p. 23). By default, the setup program will create a dedicated user account for the service.
     - Whether to allow the restart of the remote machine.
     - Whether to register the machines on the management server.
     - Whether the machines will participate in Acronis Customer Experience Program (CEP).

5. On the summary page, review the list of machines where the components will be installed, the components that will be installed, and the installation settings for those components. Click **Proceed** to start the installation.

Once the installation starts, the program displays the names of the machines on which the components are being installed.

**Update**

To update one or more components on a remote machine, repeat the installation procedure.

### 2.3.3.1 Specifying the list of machines

When adding multiple machines to the management server or when performing remote installation, you need to specify the list of machines.

**Adding machines**

Use one or more of the following options to add machines to the list:

<table>
<thead>
<tr>
<th>By IP/name</th>
<th>Type a machine name or IP address and specify the credentials of an account with administrative privileges on it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>From network</td>
<td>Specify machines by browsing the network. You can select individual machines, as well as entire workgroups or domains.</td>
</tr>
<tr>
<td>From Active Directory</td>
<td>Specify machines by browsing an Active Directory domain. This option is available only if the machine with the management console is a member of that domain.</td>
</tr>
<tr>
<td>From file</td>
<td>Import the list of the machines from a .txt or .csv file. The file should contain machine names or IP addresses and they should be one machine per line. Example:</td>
</tr>
<tr>
<td>Machine_name_1</td>
<td></td>
</tr>
<tr>
<td>Machine_name_2</td>
<td></td>
</tr>
<tr>
<td>192.168.1.14</td>
<td></td>
</tr>
<tr>
<td>192.168.1.15</td>
<td></td>
</tr>
</tbody>
</table>
From RHEV environment

This option is effective only if you use Red Hat Enterprise Virtualization earlier than 4.0. For Red Hat Virtualization (RHV) 4.0 and later, use other options.

Specify machines by connecting to a Red Hat Enterprise Virtualization Manager. Provide the credentials of the account with the access rights on the RHEV Manager. Be sure to also specify the domain name (DOMAIN\Username or Username@domain).

From the list of RHEV machines, select the machines you want to add.

By application

Specify machines on which certain applications are installed. Use the Servers and clusters found filter to show the machines that have an application you need to back up.

This option is available only when adding machines to the management server. The management server must be a member of a domain, and you can only select machines from that domain.

Specifying credentials

For each of the machines, specify the credentials of an account with administrative privileges on that machine. Or you can specify a universal account that has administrative privileges on all of the machines. Enter the account credentials for one machine and click Apply to all machines.

Note. For a machine which is a domain controller in an Active Directory domain, you must specify the name of that domain together with the user name. For example: MyDomain\Administrator

Detecting agents

Once you specify the machines to add to the management server, Acronis Backup detects the machines on which agents are not yet installed. We recommend that you wait until the detection is complete.

To cancel the detection, click Cancel status detection. In this case, agents will be installed only on the machines where the detection was completed. Of the machines where the detection was canceled, only the machines with an agent already installed will be added to the management server.

2.3.3.2 Specifying the components for remote installation

By default, the software takes the installation packages from the folder %CommonProgramFiles%\Acronis\RemoteInstaller\<product build number>. If the console is connected to the management server, the software will take the packages from the machine with the management server. Otherwise, the software will take the packages from the machine with the console.

To take the packages from a different location, click Change components source. You have the following options:

- From the registered components. The default location.
- On removable media. The software will search for the installation packages on removable media such as CD, DVD, BD, or USB flash drive.
- In the following location. Specify a local or network folder where you extracted the installation packages. If prompted for credentials, specify the user name and password.

Agent for Windows and Agent for Hyper-V depend on the Agent Core component. If you want to install these agents, the file AcronisAgentCore.msi must be present in the same location.

For more information about how to get the installation packages, refer to "Prerequisites" (p. 46).
Components that cannot be installed remotely

You cannot install the following components by using remote installation:

- Acronis Backup Agent for Exchange
- Acronis Backup Agent for SQL
- Acronis Backup Agent for Active Directory
- Acronis Backup Agent for VMware
- Acronis Backup Management Server
- Acronis Backup Storage Node
- Acronis Backup Components for Remote Installation
- Acronis PXE Server
- Acronis License Server

2.3.3.3 Installation with or without license keys

When installing agents, you need to provide license keys or choose installation without license keys.

Installing without license keys

Select Install in trial mode or for cloud backup only.

The agents will be installed in the trial mode (p. 4).

Cloud backup will be available after you activate subscriptions to the cloud backup service on the machines. Cloud backup will be available until the subscription period expires.

Please do not try to import the subscription keys to Acronis License Server or type them in the installation wizard windows.

Specifying license keys

Select one of the following:

- Specify license keys manually. You will be able to type the license keys or import them from a text file.
  When you add machines to the management server, this option is not available.
- Use licenses from the following license server. Specify the name or IP address of the license server or the management server and provide access credentials for the server.
  When you add machines to the management server, the software automatically selects the license server used by the management server. You cannot change it.

After you click Next, the software automatically assigns the available licenses to the components.

Viewing and changing the assignment of licenses

The Licensing window shows how many licenses are required and the number of deficient licenses.

To add one or more licenses, click Add license. You will be able to type the license keys or import them from a text file.

To view or change the assignment of licenses, click View license mapping. In the License Mapping window, you can set up which component will use which license, as follows:

1. Click a machine in the Machines list.
2. Under **Components**, examine which components on the machine require licenses.

3. Under **Used Licenses**, assign or reassign the licenses for these components by selecting or clearing the corresponding check boxes.

### 2.4 Installation of Agent for VMware

Agent for VMware enables backup and recovery of ESX(i) virtual machines without installing agents into the guest systems.

The agent is delivered in two versions:
- Agent for VMware (Virtual Appliance) can be imported or deployed to a VMware ESX(i) host.
- For off-loaded backup, Agent for VMware (Windows) can be installed on a machine running Windows.

**Preparation**

We highly recommend that you install Acronis Backup Management Server prior to the Agent for VMware installation. During the agent installation, specify the management server each time you are asked to register the agent or prompted for a license server (unless you chose to use a separately installed license server).

**Agent for VMware (Virtual Appliance)**

There are three methods of installing **Agent for VMware (Virtual Appliance):**

- Importing (p. 53) to a ESX(i) host as an OVF template.
  
  If you use VMware vSphere 6.5, this is the only available method. In other cases, use this method for troubleshooting purposes or if you cannot install Acronis Backup Management Server for some reason.

- Deployment from Acronis Backup Management Server to a specified host or cluster. Connect the console to the management server. In the **Navigation** tree, right click **Virtual machines**, then click **Deploy Agent for VMware**. Refer to the context help for further instructions.

- Automatic deployment from Acronis Backup Management Server. This is the easiest method. It is recommended in most cases. Connect the console to the management server. In the **Navigation** tree, right click **Virtual machines**, and then click **Configure VMware vCenter integration**. Specify the vCenter Server, and then enable **Automatic deployment**. Any time a virtual machine is selected for backup but the agent is not installed on its host, the Virtual Appliance will be automatically deployed on the host when the backup starts.

**Agent for VMware (Windows)**

If your production ESX(i) hosts are so heavily loaded that running the virtual appliances is not desirable, consider installing **Agent for VMware (Windows)** on a physical machine outside the ESX infrastructure.

If your ESX(i) uses a SAN attached storage, install the agent on a machine connected to the same SAN. The agent will back up the virtual machines directly from the storage rather than via the ESX(i) host and LAN. This capability is called a LAN-free backup.

The diagram below illustrates a LAN-based and a LAN-free backup. LAN-free access to virtual machines is available if you have a fibre channel (FC) or iSCSI Storage Area Network. To completely
eliminate transferring the backed-up data via LAN, store the backups on a local disk of the agent’s machine or on a SAN attached storage.

Agent for VMware (Windows) can be installed on any machine that runs Windows and meets the system requirements (p. 16). Follow the instructions described in the "Interactive installation of Acronis Backup Advanced" (p. 20) section.

During installation, specify the vCenter Server or ESX(i) Server whose virtual machines the agent will back up.

You will be able to set or change this setting at a later time. To access this setting after the agent has been installed, connect the console to the machine with the agent and select from the top menu Options > Machine options > Agent for VMware (Windows).

Providing licenses
Agent for VMware requires either of the following licenses to work:

- Acronis Backup Advanced for VMware
- Acronis Backup Advanced Universal License

The installation of the agent does not require a license. However, you must specify a license server. Once the agent starts backing up a virtual machine, the agent checks whether the virtual machine’s host has a license. If it does not have one, the agent takes a free license from the specified license server and assigns it to the host. If the host is included in a cluster, licenses will be assigned to all of the clustered hosts. Therefore, you need one license for each clustered ESX(i). This ensures the uninterrupted operation of your backup plans when virtual machines are moved around the cluster.
2.4.1 Importing Agent for VMware (Virtual Appliance)

If you use VMware vSphere 6.5, this is the only available method of installing Agent for VMware (Virtual Appliance). In other cases, use this method for troubleshooting purposes or if you cannot install Acronis Backup Management Server for some reason.

2.4.1.1 Step 1: Extracting the OVF template

If you use VMware vSphere 6.5
1. Download the installation package of the 64-bit Agent for VMware (Virtual Appliance) from the Acronis website.
2. On a machine running 64-bit Windows, run the installation package.
3. Follow the on-screen instructions.

After the installation is complete, the virtual appliance's files will be located in the folder %ProgramFiles(x86)\Acronis\ESXAppliance. Share this folder and grant users Read access to it, if you run the vSphere Client on a different machine.

If you use VMware vSphere versions earlier than 6.5
1. On a machine running Windows, start the Acronis Backup setup program.
2. Click Extract installation files. Then, in the list of installation packages, select the Agent for VMware (Virtual Appliance) (AcronisVirtualAppliance.msi) check box.
   Tip: Alternatively, you can click Install Acronis Backup, select the I want to manually select the Acronis components... check box, and then select the Agent for VMware (Virtual Appliance) check box in the list of components. Complete the installation and skip steps 3 and 4.
3. In Extract to, specify the folder to which you want to extract the virtual appliance's installation package, and then click Extract.
4. Run the extracted installation package.

After the installation is complete, the virtual appliance's files will be located in the folder %ProgramFiles\Acronis\ESXAppliance (in 32-bit Windows)
or %ProgramFiles(x86)\Acronis\ESXAppliance (in 64-bit Windows). Share this folder and grant users Read access to it, if you run the vSphere Client on a different machine.

2.4.1.2 Step 2: Deploying the OVF template

1. Start the vSphere Client and log on to the ESX(i) server.
2. On the File menu, point to Deploy OVF Template. Follow the Deploy OVF Template wizard.
   Tip: In VMware Infrastructure, point to Virtual Appliance, and then click Import. Follow the Import Virtual Appliance wizard.
3. In Source, select Deploy from File, and then specify the path to the virtual appliance's OVF package—normally: %ProgramFiles\Acronis\ESXAppliance (in 32-bit Windows)
or %ProgramFiles(x86)\Acronis\ESXAppliance (in 64-bit Windows).
4. Review the OVF Template Details and click Next.
5. In Name and Location, type the name for the appliance or leave the default name AcronisESXAppliance.
6. In Network mapping, select the bridged mode for the network adapter.
7. In Datastore, leave the default datastore unless it does not have enough space for the virtual appliance. In this case, select another datastore. Skip this step if there is only one datastore on the server.
8. Review the summary and then click Finish. After the successful deployment is reported, close the progress window.

2.4.1.3 Step 3: Configuring the virtual appliance

1. Starting the virtual appliance
   In the vSphere Client, display the Inventory, right-click the virtual appliance's name, and then select Power > Power On.
   Select the Console tab. The virtual appliance welcome screen tells you what to do next. Click Close. You will be able to access this screen at any time by clicking the help button in the virtual appliance GUI.
   You are taken to the Acronis Backup Agent for VMware screen where you continue the agent configuration.

2. Time zone
   Under Virtual machine, in Time zone, click Change and select the time zone for the location where the management console is installed.
   An ESX(i) server always works in the GMT time zone. When being imported, a virtual appliance inherits the GMT time zone from the server. If the console works in another time zone, you need to synchronize the virtual appliance with the console to ensure that the tasks scheduled with the console run at the appropriate time.

3. vCenter/ESX(i)
   Under Agent options, in vCenter/ESX(i), click Change and specify the vCenter Server name or IP address. The agent will be able to back up and recover any virtual machine managed by the vCenter Server.
   If you do not use a vCenter Server, specify name or IP address of the ESX(i) host whose virtual machines you want to back up and recover. Normally, backups run faster when the agent backs up virtual machines hosted on its own host.
   Specify the credentials that the agent will use to connect to the vCenter Server or ESX(i). We recommend that the account have the necessary privileges for backup and recovery on the vCenter Server or ESX(i). You can click Check connection to ensure the access credentials are correct.

The virtual appliance is ready to work. In addition, you can change the following settings:

- **Network settings**
  The agent’s network connection is configured automatically by using Dynamic Host Configuration Protocol (DHCP). To change the default configuration, under Agent options, in eth0, click Change and specify the desired network settings.

- **Local storages**
  You can attach an additional disk to the virtual appliance so the Agent for VMware can back up to this locally attached storage. Such backup is normally faster than a backup via LAN and it does not consume the network bandwidth.
  The virtual disk size must be at least 10 GB. Add the disk by editing the settings of the virtual machine and click Refresh. The Create storage link becomes available. Click this link, select the disk and specify a label for it.

*Be careful when adding an already existing disk. Once the storage is created, all data previously contained on this disk will be lost.*
2.4.1.4  Step 4: Adding the virtual appliance to the management server

The minimum set of components that enables backing up virtual machines from a host includes the management console, the license server and the agent. With this set, you can back up and recover virtual machines using the direct console-agent connection.

However, Acronis highly recommends that you install and use Acronis Backup Management Server, even if you have only one ESX(i) host. The management server lets you easily deploy and update agents, set up and monitor backups of your virtual machines. If, for better performance, you configure several agents to manage the same host, the management server will automatically distribute virtual machines between the agents. This is necessary to equalize the agents’ load and to avoid a conflict of snapshots which may occur if two agents try to back up a virtual machine simultaneously.

If you are planning to use the management server, register the virtual appliance on the server.

To add the virtual appliance to the management server

2. Connect the management console to the virtual appliance using the IP address displayed in the virtual appliance console.
3. Select Options > Machine options > Machine management from the top menu.
4. Select Centralized management and specify the management server IP/name. Click OK.
5. Specify the user name and password for the management server administrator’s account. Click OK.

Alternatively, you can add the appliance to the management server on the server’s side.

2.4.2  Updating Agent for VMware (Virtual Appliance)

Update from the management server

This update method applies only to those virtual appliances that are registered on the management server. This method is preferable to the manual procedure described later in this section, because all configuration settings (local backup plans, centralized backup plans and group membership) related to the virtual machines managed by the agent will be preserved in this case.

Prerequisites

To perform operations described in this section, Acronis Backup Management Server uses a number of TCP ports:

- Ports 443 and 902 are used to access the vCenter Server and ESX(i) hosts.
- Port 9876 is used to access Agent for VMware (Virtual Appliance).

If the management server uses a custom firewall, ensure that this firewall allows outgoing connections to these ports. Windows Firewall is configured automatically by Acronis Backup.

If the traffic from the management server to the vCenter Server, the ESX(i) hosts, or the agents goes through a router or a similar network device, ensure that the device does not block this traffic.

No special configuration is required on the vCenter Server or the ESX(i) hosts.

To update the virtual appliances from the management server

1. Update the management console and the management server.
2. Connect the console to the management server.
3. In the **Navigation** tree, right-click the group that has the same name as the vCenter Server. If VMware vCenter integration is not enabled, right-click **Virtual machines**.

4. Click **Update Agent for VMware**.

5. Select the agents that you want to update. Agents that are already of the latest version are unavailable for selection.

6. Click **Update Agent for VMware**.

The virtual appliances will be updated; the agents' configuration settings will be preserved.

**Manual update**

Manual update of the virtual appliance involves installing a new appliance and deleting the old one. Use this method only if updating from the management server is not possible for some reason.

After manually updating the virtual appliance, you will have to re-create local backup plans that existed on the appliance.

**To update the virtual appliance (VA) manually**

1. Install and configure the new VA, as described in "Importing Agent for VMware (Virtual Appliance)" (p. 53).

2. Delete (p. 65) the old virtual appliance from the ESX(i) server.

3. [Optional] **Re-create local backup plans** that previously existed on the VA if you want to continue using them.

4. [Optional] Re-establish the machines' membership in **dynamic groups** that use the **All VMs backed up by agent** criterion. To do this, specify the updated VA as a criterion for the group.

   **Details.** The machines' membership in such dynamic groups is lost because the old VA is removed from the management server during update.

You do not need to re-add either static or dynamic custom groups to the centralized backup plans. As soon as the machines' membership in the groups is re-established, the appropriate backup plans will continue protecting the machines.

2.5 **Installation of Agent for Hyper-V**

Agent for Hyper-V enables you to back up and recover virtual machines from a Hyper-V host without installing agents on the virtual machines.

**Preparation**

**Licenses.** Ensure that you have a sufficient number of Acronis Backup Advanced licenses (Universal or for Hyper-V). You need one license per Hyper-V host. If you have a Hyper-V cluster (also called a failover cluster), we recommend obtaining licenses for each node of the cluster. To use the product in the trial mode, you do not need licenses.

**Management server.** We recommend installing Acronis Backup Management Server and importing the licenses. If you have a Hyper-V cluster, installing the management server will enable you to back up clustered virtual machines whatever node they are running on.

**Installation**

Install the agent on the Hyper-V host. In a Hyper-V cluster, install the agent on each node of the cluster.
In Windows Server, you can install the agent from the setup program (p. 20). Select the **Back up this machine’s data** check box and follow the on-screen instructions.

In Microsoft Hyper-V Server, you can install the agent remotely (p. 45).

If prompted for the Acronis Managed Machine Service (agent) account, specify an account of a domain user who has administrative privileges on all nodes of your Hyper-V cluster. With this account the agent will be able to access virtual machines on any of the nodes. Alternatively, you can choose to create a new account for the agent. Then, when creating centralized backup plans or recovery tasks, you will need to specify credentials for the domain account with the necessary privileges.

If you installed the management server, choose to register the agent on it during installation.

### 2.6 Installation for other virtualization platforms

Unlike ESX and Hyper-V, the following virtualization platforms require that an agent is installed on a virtual machine:

- Citrix XenServer
- Red Hat Enterprise Virtualization (RHEV)
- Kernel-based Virtual Machines (KVM)
- Oracle VM Server, Oracle VM VirtualBox
- Parallels Server Bare Metal

For the complete list of supported virtualization platforms, refer to "Supported virtualization platforms" in the "Backing up virtual machines" document.

For information about the required licenses, refer to "Licensing for virtual machines" (p. 12).

**If you need to back up the virtual machines**

Install Acronis Backup Agent for Windows or Acronis Backup Agent for Linux on every virtual machine you want to back up. For step-by-step instructions, refer to "Installation in Windows" (p. 18), "Installation in Linux" (p. 39), or "Remote installation" (p. 45).

If you use Red Hat Enterprise Virtualization, be sure to familiarize yourself with the "Backup and recovery of RHEV virtual machines" section of the "Backing up virtual machines" document. This document contains step-by-step instructions on installing the agents and adding the machines to the management server.

The backup and recovery operations are the same as with a physical machine. You can also use bootable media to do "cold" backups and "bare metal" recovery to an empty virtual machine.

**If you need to back up the virtualization host**

Acronis Backup enables you to back up the physical host by using the same license as for the hosted virtual machines.

If the host is running an operating system supported by Agent for Windows or Agent for Linux (see "Supported operating systems" (p. 12)), you can install the corresponding agent on the host. You can also use bootable media to do "cold" backups and "bare metal" recovery.

If the host is not running a supported operating system, you have only one option: a sector-by-sector backup by using bootable media. While recovery from such a backup is possible, Acronis cannot guarantee that the system boots and will be fully operational.
2.7 Installation of Agent for Exchange

Agent for Exchange can only be installed on a machine running the Mailbox role of Microsoft Exchange Server. Remote installation of the agent is not possible.

The agent is included in the setup program of Acronis Backup Advanced.

The agent is installed with Agent for Windows (p. 6) or on a machine where Agent for Windows is already installed.

Preparation

Licenses. Ensure that you have a sufficient number of licenses. You need one license per Exchange server. If you have an Exchange cluster, we recommend obtaining licenses for each node of the cluster.

Agent for Exchange requires one of the following licenses:

- Acronis Backup Advanced for Exchange
- Acronis Backup for Windows Server Essentials
- Acronis Backup Advanced for VMware / Hyper-V / RHEV / Citrix XenServer / Oracle VM
- Acronis Backup Advanced Universal License

Each of these licenses enables you to install Agent for Windows on the same machine. Therefore, you can back up the entire machine in addition to Exchange databases and mailboxes.

If Agent for Windows is already installed, you can install Agent for Exchange by using the Acronis Backup Advanced for Exchange Add-On license.

To use the product in the trial mode, you do not need licenses.

Requirements. Ensure that the Exchange server meets the following requirements:

- For Microsoft Exchange Server 2013: Cumulative Update 1 (CU1) or later must be installed.
- The Exchange writer for VSS must be turned on. In Windows Small Business Server 2003, the writer is turned off by default. For instructions on how to turn it on, see the following Microsoft Knowledge Base article http://support.microsoft.com/kb/838183/.

Installation procedure

Remote installation of Agent for Exchange is not possible, because the agent setup has certain requirements that can be checked in the local interactive installation mode only.

Installing the agent on an Exchange server

1. Run the setup program.
2. Proceed to the window where you are asked how you want to use this machine and select the Back up this machine's data check box.
3. Follow the on-screen instructions (p. 20). If you installed the management server, choose to register Agent for Exchange on it during installation.
Installing agents on Exchange cluster nodes

To back up data in an Exchange cluster, install the agent on each node of the cluster. When installing the agent on a cluster node, specify an existing account of a domain user for the agent service. With this account, the agent will be able to access the clustered data on any of the nodes. The account must have administrative privileges on each of the cluster nodes.

To install the agent on a cluster node

1. Run the setup program.
2. Proceed to the window where you are asked how you want to use this machine and select the I want to manually select the Acronis components and customize the installation process check box.
3. In the components tree, select Agent for Exchange. Agent for Windows is selected automatically.
4. Follow the on-screen instructions.
   Details. When prompted to assign logon accounts to the Acronis services, in Acronis Managed Machine Service account, select Use an existing account and specify the account that has administrative privileges on each of the cluster nodes. Alternatively, you can choose to create a new account for the agent. Then, when creating centralized backup plans or recovery tasks, you will need to specify credentials for the domain account that has the necessary privileges.
   If you installed the management server, choose to register Agent for Exchange on it during installation.

2.8 Installation of Agent for SQL

Agent for SQL enables you to create single-pass disk and application backups and to recover Microsoft SQL databases from them.

Agent for SQL can only be installed on a machine running Microsoft SQL Server. Remote installation of the agent is not possible.

The agent is included in the setup program of Acronis Backup Advanced.

The agent is installed with Agent for Windows (p. 6) or on a machine where Agent for Windows is already installed.

Licenses required

Agent for SQL requires one of the following licenses:

- Acronis Backup Advanced for SQL
- Acronis Backup Advanced for SharePoint
- Acronis Backup for Windows Server Essentials
- Acronis Backup Advanced for VMware / Hyper-V / RHEV / Citrix XenServer / Oracle VM
- Acronis Backup Advanced Universal License

Each of these licenses enables you to install Agent for Windows on the same machine. If Agent for Windows is already installed, you can install Agent for SQL by using one of the add-on licenses:

- Acronis Backup Advanced for SQL Add-On
- Acronis Backup Advanced for SharePoint Add-On.

To use the product in the trial mode, you do not need licenses.
Installation

Install the agent in the same way as Agent for Windows. For detailed step-by-step instructions, refer to the "Interactive installation of Acronis Backup Advanced" (p. 20) section of the installation documentation.

Credentials for Microsoft SQL instances

During the installation, you are asked to specify the sysadmin credentials for each Microsoft SQL instance installed on the machine. These credentials are required to grant the sysadmin role to the agent service account.

You can skip entering the credentials and grant the agent the sysadmin role later in any of the following ways:

- By clicking Tools > Provide SQL Server credentials when Acronis Backup Management Console is connected to the machine.
- By using SQL Server Management Studio.
- By running a T-SQL script.

For more information, see "Permissions for SQL Server backup and recovery" in the product Help or the User Guide.

2.9 Installation of Agent for Active Directory

Agent for Active Directory enables you to create single-pass disk and application backups and to recover Microsoft Active Directory data from them.

Agent for Active Directory can only be installed on a domain controller. Remote installation of the agent is not possible.

The agent is included in the setup program of Acronis Backup Advanced.

The agent is installed with Agent for Windows (p. 6) or on a machine where Agent for Windows is already installed.

Licenses required

Agent for Active Directory requires one of the following licenses:

- Acronis Backup Advanced for Active Directory
- Acronis Backup for Windows Server Essentials
- Acronis Backup Advanced for VMware / Hyper-V / RHEV / Citrix XenServer / Oracle VM
- Acronis Backup Advanced Universal License

Each of these licenses enables you to install Agent for Windows on the same machine. If Agent for Windows is already installed, you can install Agent for Active Directory by using the Acronis Backup Advanced for Active Directory Add-On license.

To use the product in the trial mode, you do not need licenses.

Installation

Install the agent in the same way as Agent for Windows. When asked for credentials for the Acronis Managed Machine Service, specify an existing domain user account that is included in the built-in
Administrators group of the domain controller. Otherwise, single-pass backups of Microsoft Active Directory data will fail.

For detailed step-by-step instructions, refer to the "Interactive installation of Acronis Backup Advanced" (p. 20) section of the installation documentation.

3 Upgrading from Acronis Backup to Acronis Backup Advanced

Purchasing licenses

Prior to upgrade, purchase the Acronis Backup Advanced licenses for each machine where you are planning to upgrade Acronis Backup. Names of the licenses depend on the product currently installed on the machine.

<table>
<thead>
<tr>
<th>Installed product</th>
<th>Licenses suitable for upgrade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acronis Backup for Windows Server</td>
<td>Acronis Backup Advanced for Windows Server</td>
</tr>
<tr>
<td>Acronis Backup for Linux Server</td>
<td>Acronis Backup Advanced for Linux Server</td>
</tr>
<tr>
<td>Acronis Backup for PC</td>
<td>Acronis Backup Advanced for PC</td>
</tr>
</tbody>
</table>

After the purchase, you will receive an e-mail with the license keys.

Upgrading the product

To upgrade Acronis Backup to Acronis Backup Advanced, do the following:

Step 1. Changing licenses

On each machine where you want to upgrade Acronis Backup, change a license as follows:

1. Run Acronis Backup.
2. On the Help menu, click Change license.
3. Click Change to the right of License for backup of disks/files, click Change, and then click Use the following license keys.
4. Enter the new license keys for this machine.
5. Click OK to apply the new licenses, click Yes in the warning message, and then click OK.

The licenses previously assigned to the machine will be revoked and the management console will restart. Now, you can connect the console to a remote machine and connect to this machine from a remote location.

Step 2. Downloading the setup program

Download the setup program of Acronis Backup Advanced from the Acronis website as described at http://kb.acronis.com/content/1642.

Step 3. Installing the management server

Install Acronis Backup Management Server on a machine running Windows. The machine must have at least 8 GB of RAM and 4.5 GB of free space on a system disk.

It is acceptable to install the management server on one of the machines where you have upgraded the product. To do this:
1. Run the setup program, and then click **Install Acronis Backup**.
2. After accepting the terms of the license agreement, click **Modify**.
3. In the components tree, select **Management Server**.
4. Follow the on-screen instructions. In most cases, you can leave the default settings.

In large environments, we recommend setting up a dedicated physical or virtual server. For detailed information, refer to the installation documentation for Acronis Backup Advanced (p. 20).

**Step 4. Adding the upgraded machines to the management server**

1. On any machine where the product was upgraded, run Acronis Backup.
2. Click **Connect to a management server** and type the server name or IP address. If prompted for credentials, specify the user name and password of a user who is a member of the **Acronis Centralized Admins** and **Acronis Remote Users** groups on the management server.
3. In the **Navigation** tree, select **Machines with agents**.
4. Click **Add multiple machines** on the toolbar.
5. Add the upgraded machines in any of the following ways:
   - By specifying their names or IP addresses.
   - By browsing the network.
   - By browsing an Active Directory domain.
   - By importing a list of machines from a .txt or .csv file.

For detailed information, refer to the "Specifying the list of machines" (p. 48) section of the installation documentation for Acronis Backup Advanced.

**Tips for further usage**

The added machines will appear in the **Machines with agents** view of the management server.

The backup plans on the machines will remain intact. To view them on the management server, right-click the machine name > **View details** > **Backup plans and tasks**. The product continues doing backups and you can recover from the backups created before the upgrade.

You can now create centralized backup plans that will simultaneously back up several machines to a single location.

### 4 Checking for software updates

Each time you start the management console, Acronis Backup checks whether a new version of the software is available on the Acronis website. If so, the software provides a link for downloading a setup program of the new version.

To check for updates manually, start the management console and then click **Help > Check for updates**. In that window, you can also disable the automatic checks for updates.

Another way to enable or disable the automatic checks for updates is to configure Acronis Administrative Template. In this case, the parameter value set in the administrative template will supersede the setting in the **Check for updates** window. For more details, see "Parameters set through administrative template" in the product Help or the User Guide.

For information about updating Acronis Backup, see the "Update" section (p. 29) (for local installation in Windows) or the corresponding installation section (for other ways of installation).
5 Uninstallation

5.1 Uninstalling Acronis Backup Advanced

When you uninstall a component that uses a license on Acronis License Server, the license remains assigned to the machine. If you want to use this license for a different machine, revoke the license manually.

5.1.1 Uninstallation in Windows

5.1.1.1 Interactive uninstallation

To uninstall Acronis Backup Advanced or its components, we recommend using the following procedures instead of the Add or Remove Programs or Programs and Features tool of Windows.

To uninstall all components of Acronis Backup Advanced
1. Click Start -> All Programs -> Acronis -> Uninstall Acronis Backup.
2. To delete associated information (see later in this topic), select the Remove the product's log, tasks, vaults and configuration settings check box.
3. Click Remove.

To uninstall individual components or features of Acronis Backup Advanced
1. Start the Acronis Backup Advanced setup program.
2. Click Install Acronis Backup.
3. Click Modify.
4. Clear the check boxes next to the names of the components or features that you want to uninstall.
5. To delete associated information (see later in this section), select the Remove the product's log, tasks, vaults and configuration settings check box.

Deleting associated information

If you are planning to reinstall a component at a later time, you may want to keep its associated information.

If instead you want to delete this information, select the Remove the product's log, tasks, vaults and configuration settings check box. As a result, the following information will be deleted:

- When uninstalling Acronis Backup Agent for Windows: the log and tasks of the agent
- When uninstalling Acronis Backup Management Server: the management server databases, which store the configuration of centralized backup plans, the operation log, and statistics
- When uninstalling Acronis Backup Storage Node: the log and tasks of the storage node

5.1.1.2 Unattended uninstallation

To uninstall a component or feature of Acronis Backup in the unattended mode, you need to run the msiexec utility. This utility uses the corresponding installation package (an .msi file).

To uninstall a component or feature
1. Extract the corresponding installation package to a folder or a network share.
2. Run the following command (here, the installation package is assumed to be AcronisAgentWindows.msi, saved in the \myserver\share network share):

```bash
msiexec /uninstall \myserver\share\AcronisAgentWindows.msi /qb
```

**Uninstalling an agent**

When you uninstall an agent, we recommend first uninstalling its features, then the agent itself and then the Acronis Backup Agent Core component.

For example, to uninstall Agent for SQL, run uninstallation commands in the following order:

```bash
msiexec /uninstall \myserver\share\AcronisAgentMsSqlSinglePass.msi /qb
msiexec /uninstall \myserver\share\AcronisAgentWindows.msi /qb
msiexec /uninstall \myserver\share\AcronisAgentCore.msi /qb
```

**Uninstalling the license server**

If you need to uninstall the Acronis License Server, you should do so after uninstalling all agents that use it. Also keep in mind that the license server may be used by other Acronis products.

The license server is integrated with the management server. To uninstall the management server, run the following command (change the path if needed):

```bash
msiexec /uninstall \myserver\share\AcronisManagementServer.msi /qb
```

To uninstall the license server installed as a separate component, run the following command (change the path if needed):

```bash
msiexec /uninstall \myserver\share\AcronisLicenseServer.msi /qb
```

5.1.1.3 **Remote uninstallation**

The remote uninstallation is performed by using the `remote_uninstaller.exe` utility. It allows you to uninstall all Acronis Backup components from the specified machines running Windows. The logs, tasks, vaults, and configuration settings on the machines remain intact.

The utility is available on any Windows machine where Acronis Backup Management Console or Acronis Backup Management Server is installed. The path to the utility is as follows:

- In a 32-bit version of Windows: `%CommonProgramFiles%\Acronis\BackupAndRecovery\Common`  
- In a 64-bit version of Windows: `%CommonProgramFiles(x86)%\Acronis\BackupAndRecovery\Common`

**Preparation**

Preparatory steps on each of the machines are the same as for remote installation (p. 46).

**Running the utility**

In the command line, type the full path to the utility and the full path to a text file with the list of required machines.

Each line of the specified file must contain information about one machine in the following format:

```plaintext
<machine IP address or hostname>;<user name>;<password>
```

**Example**
C:\machines_list.txt

where the file **machines_list.txt** contains the following lines:

```
10.200.200.10;usr5;123456
10.200.200.15;admin25;"654 321"
```

When you run the utility, it shows whether the uninstallation process has started successfully on each machine. The utility does not report whether the uninstallation has been successful or not.

### 5.1.2 Uninstallation in Linux

**To uninstall all components of Acronis Backup Advanced**

Do the following as the root user:

1. Run the following commands to uninstall Acronis Backup Advanced components:
   ```
   # /usr/lib/Acronis/BackupAndRecovery/uninstall/uninstall
   # /usr/lib/Acronis/BootableComponents/uninstall/uninstall
   # /usr/lib/Acronis/BackupAndRecoveryConsole/uninstall/uninstall
   ```
   To uninstall all components in the unattended mode, run each of the `/uninstall` commands with the `-a` parameter.

2. Run the following command to delete the source files of the SnapAPI module:
   ```
   # rm -rf /usr/src/snapapi*
   ```

### 5.2 Deleting Agent for VMware (Virtual Appliance)

**Acronis Backup Management Server provides an easy way to remove Agent for VMware from ESX or ESXi servers. You might generally prefer that method to the procedure described later in this section.**

Connect the console to the management server. In the Navigation tree, right-click Virtual machines, then click Remove Agent for VMware. Refer to the context help for further instructions.

You may need to manually delete the Agent for VMware (Virtual Appliance), or VA, in the following cases:

- The VA is not registered on the management server.
- You are not using vCenter Server or integration with vCenter Server is not enabled.
- The VA is corrupted.

**To remove Agent for VMware (Virtual Appliance) manually**

1. Start VMware vSphere Client and log on to the ESX(i) host or to vCenter Server.
2. Power off the VA.
3. If the VA uses a locally attached storage on a virtual disk, and you want to preserve data on that disk, do the following:
   a. Right-click the VA, and then click **Edit Settings**.
   b. Select the disk with the storage, and then click **Remove**. Under **Removal Options**, click **Remove from virtual machine**.
   c. Click **OK**. As a result, the disk remains in the datastore. You can attach the disk to another VA.
4. Right-click the VA, and then click **Delete from Disk**.
5. Remove the VA from the management server. Skip this step if the appliance is not registered on the management server or has been already removed.
To remove the VA, connect to the management server, right-click the VA in the All physical machines list, and then click Delete machine from AMS.

5.3 Deleting Acronis Secure Zone

Uninstallation of Acronis Backup does not affect Acronis Secure Zone and its contents. You will still be able to recover data from Acronis Secure Zone on booting from bootable media.

If you need to delete Acronis Secure Zone, perform the following steps in the operating system (before the agent uninstallation) or under bootable media.

To delete Acronis Secure Zone
1. On the Actions menu, click Manage Acronis Secure Zone.
2. In the Delete Acronis Secure Zone window, select volumes to which you want to add the space freed from the zone and then click OK.
   - If you select several volumes, the space will be distributed proportionally to each partition. If you do not select any volume, the freed space becomes unallocated.

After you click OK, Acronis Backup will start deleting the zone.
Copyright Statement

Copyright © Acronis International GmbH, 2002-2017. All rights reserved.

“Acronis” and “Acronis Secure Zone” are registered trademarks of Acronis International GmbH.

“Acronis Compute with Confidence”, “Acronis Startup Recovery Manager”, “Acronis Instant Restore” and the Acronis logo are trademarks of Acronis International GmbH.

Linux is a registered trademark of Linus Torvalds.

VMware and VMware Ready are trademarks and/or registered trademarks of VMware, Inc. in the United States and/or other jurisdictions.

Windows and MS-DOS are registered trademarks of Microsoft Corporation.

All other trademarks and copyrights referred to are the property of their respective owners.

Distribution of substantively modified versions of this document is prohibited without the explicit permission of the copyright holder.

Distribution of this work or derivative work in any standard (paper) book form for commercial purposes is prohibited unless prior permission is obtained from the copyright holder.

DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

Third party code may be provided with the Software and/or Service. The license terms for such third-parties are detailed in the license.txt file located in the root installation directory. You can always find the latest up-to-date list of the third party code and the associated license terms used with the Software and/or Service at http://kb.acronis.com/content/7696

Acronis patented technologies

Technologies, used in this product, are covered and protected by one or more U.S. Patent Numbers: 7,047,380; 7,246,211; 7,275,139; 7,281,104; 7,318,135; 7,353,355; 7,366,859; 7,383,327; 7,475,282; 7,603,533; 7,636,824; 7,650,473; 7,721,138; 7,779,221; 7,831,789; 7,836,053; 7,886,120; 7,895,403; 7,934,064; 7,937,612; 7,941,510; 7,949,635; 7,953,948; 7,979,690; 8,005,797; 8,051,044; 8,069,320; 8,073,815; 8,074,035; 8,074,276; 8,145,607; 8,180,984; 8,225,133; 8,261,035; 8,296,264; 8,312,259; 8,347,137; 8,484,427; 8,645,748; 8,732,121; 8,850,060; 8,856,927; 8,996,830; 9,213,697; 9,400,886; 9,424,678; 9,436,558; 9,471,441; 9,501,234; and patent pending applications.